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マイクロチップ社製デバイスのコード保護機能に関して以下の点にご注意ください。

• マイクロチップ社製品は、該当するマイクロチップ社データシートに記載の仕様を満たしています。

• マイクロチップ社では、通常の条件ならびに仕様に従って使用した場合、マイクロチップ社製品のセキュリティ レベルは、

現在市場に流通している同種製品の中でも最も高度であると考えています。

• しかし、コード保護機能を解除するための不正かつ違法な方法が存在する事もまた事実です。弊社の理解では、こうした手法

はマイクロチップ社データシートにある動作仕様書以外の方法でマイクロチップ社製品を使用する事になります。このような

行為は知的所有権の侵害に該当する可能性が非常に高いと言えます。

• マイクロチップ社は、コードの保全性に懸念を抱いているお客様と連携し、対応策に取り組んでいきます。

• マイクロチップ社を含む全ての半導体メーカーで、自社のコードのセキュリティを完全に保証できる企業はありません。コー

ド保護機能とは、マイクロチップ社が製品を「解読不能」として保証するものではありません。

コード保護機能は常に進歩しています。マイクロチップ社では、常に製品のコード保護機能の改善に取り組んでいます。マイクロ

チップ社のコード保護機能の侵害は、デジタル ミレニアム著作権法に違反します。そのような行為によってソフトウェアまたはそ

の他の著作物に不正なアクセスを受けた場合、デジタル ミレニアム著作権法の定めるところにより損害賠償訴訟を起こす権利があ

ります。
本書に記載されているデバイス アプリケーション等に関する

情報は、ユーザの便宜のためにのみ提供されているものであ

り、更新によって無効とされる事があります。お客様のアプ

リケーションが仕様を満たす事を保証する責任は、お客様に

あります。マイクロチップ社は、明示的、暗黙的、書面、口

頭、法定のいずれであるかを問わず、本書に記載されている

情報に関して、状態、品質、性能、商品性、特定目的への適

合性をはじめとする、いかなる類の表明も保証も行いません。

マイクロチップ社は、本書の情報およびその使用に起因する

一切の責任を否認します。マイクロチップ社の明示的な書面

による承認なしに、生命維持装置あるいは生命安全用途にマ

イクロチップ社の製品を使用する事は全て購入者のリスクと

し、また購入者はこれによって発生したあらゆる損害、クレー

ム、訴訟、費用に関して、マイクロチップ社は擁護され、免

責され、損害を受けない事に同意するものとします。暗黙的

あるいは明示的を問わず、マイクロチップ社が知的財産権を

保有しているライセンスは一切譲渡されません。
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序章
はじめに

ここでは、PICkit™ 3 プログラマ / デバッガを使用する前に知っておくと便利な一般
的な情報について説明します。この章の内容は以下の通りです。

• 本書の構成

• 本書の表記規則

• 保証登録

• 推奨参考資料

• マイクロチップ社のウェブサイト

• 開発システムのお客様向け通知サービス

• カスタマ サポート

• 改訂履歴

お客様へのご注意

全ての文書の内容は時間と共に古くなります。本書も例外ではありません。マイクロチップ社のツー
ルとマニュアルはお客様のニーズを満たすために常に改良を重ねており、実際のダイアログやツール
の内容が本書に記載されているものと異なる場合があります。
最新の文書は弊社ウェブサイト (www.microchip.com) をご覧ください。

文書は「DS」番号で識別します。この識別番号は、各ページのフッタ部分、ページ番号の前に記載し
ています。DS 番号の表記規則は「DSXXXXXA」で、「XXXXX」が文書番号、「A」が文書のリビジョン 
レベルを表しています。

開発ツールについての最新情報は、MPLAB® IDE のオンラインヘルプをご覧ください。[Help] メニュー
を選択して、次に [Topics] を選択すると、利用できるオンラインヘルプ ファイルのリストが表示され
ます。
 2012 Microchip Technology Inc. DS51795B_JP - p.5
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本書の構成

本書では、PICkit 3 を開発ツールとして使用し、ターゲットボードのファームウェア
のエミュレーションとデバッグを行う方法を説明します。本書の構成は以下の通り
です。

• Chapter 1. 概要 – PICkit 3 プログラマ / デバッガの概要を説明します。

• Chapter 2. 動作原理 – PICkit 3 プログラマ / デバッガの動作原理を簡単に説明します。

• Chapter 3. インストール – PICkit 3 プログラマ / デバッガのインストール方法を説明します。

• Chapter 4. 全般的な設定 – PICkit 3 プログラマ / デバッガを使ってデバイスをプログラムする
手順について説明します。

• Chapter 5. PICkit 3 Debug Express – PICkit™ 3 Debug Express の基本的な使用方法を説
明します。

• Chapter 6. PICkit 3 Programmer-To-Go – PC に接続せず PICkit 3 を使ってデバイスをプロ
グラムする方法を説明します。

• Chapter 7. トラブルシュート – トラブルシュートの手順を説明します。最初に確認する項
目とデバッグに失敗する一般的な原因を示します。

• Chapter 8. よく寄せられる質問 (FAQ) – 一般的な問題の解決方法を説明します。

• Chapter 9. エラーメッセージ – エラーメッセージとそれらに対する一般的な対処方法を説明
します。

• Chapter 10. デバッガ機能一覧 – 利用可能なデバッグ機能をまとめています。

• 補遺 A. ハードウェア仕様 – PICkit 3 のハードウェア仕様と電気的仕様を詳しく説明します。

• 補遺 B. PICkit 3 の回路図 – PICkit 3 プログラマ / デバッガのハードウェア回路図を示します。
DS51795B_JP - p.6   2012 Microchip Technology Inc.



序章
本書の表記規則

本書では以下の表記規則を使用します。

本書の表記規則

説明 意味 例

ゴシックフォント :

斜体 参考資料 MPLAB® IDE User’s Guide

強調文字 ... は唯一のコンパイラです ...

角カッコ : [ ] ウィンドウ [Output] ウィンドウ

ダイアログ [Settings] ダイアログ

メニューの選択肢 [Enable Programmer] を選択

かぎカッコ : 「 」 ウィンドウまたはダイアロ
グのフィールド名

「Save project before build」

右山カッコ (>) を使用し、角
カッコで囲まれた下線付き斜
体テキスト

メニューパス [File]>[Save]

太字で角カッコに囲まれた
テキスト

ダイアログのボタン [OK] をクリックする。

タブ [Power] タブをクリックする。

山カッコで囲まれたテキスト : 
< >

キーボードのキー <Enter>、<F1> を押す。

Courier New フォント :

プレーン ( 斜体、太字でない ) サンプル ソースコード #define START

ファイル名 autoexec.bat

ファイルパス c:\mcc18\h

キーワード _asm, _endasm, static

コマンドライン オプション -Opa+, -Opa-

ビット値 0, 1

定数 0xFF,’A’

斜体 変数の引数 file.o (file は有効なファイル名 )

角カッコ : [ ] オプションの引数 mpasmwin [オプション] file 
[ オプション ]

中カッコとパイプ文字 :
 { | } 

いずれかの引数を選択する
場合 (OR 選択 )

errorlevel {0|1}

省略記号 : ... 繰り返されるテキスト var_name [, 
var_name...]

ユーザが定義するコード void main (void)
{ ...
}

 2012 Microchip Technology Inc. DS51795B_JP - p.7
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保証登録

同封の保証登録カードにご記入いただき、お早めにご郵送ください。この保証登録
カードを送付されたお客様には、製品のアップデート情報をお送りします。ソフト
ウェアのマイナー リリースは弊社ウェブサイトで提供しております。

推奨参考資料

本書は、PICkit 3 の使用方法を説明したものです。他にも便利な文書がありますの
で、以下に一覧でご紹介します。以下に記載したマイクロチップ社の文書を参考資
料としてお読みになる事をお勧めします。

『In-Circuit Debugger Design Advisory』(DS51764)

まず、この文書を最初にお読みください。この文書には、PICkit 3 を使用する際に注
意すべき重要な情報が記載されています。

『44-Pin Demo Board User’s Guide』(DS41296)

44 ピンデモボードを開発ツールとして使ってターゲットボードのファームウェアの
エミュレーションとデバッグを行う方法については、この文書を参照してください。

『Low Pin Count Demo Board User’s Guide』(DS51556)

マイクロチップ社の少ピンデバイス (8/14/20 ピン ) を使う方法については、この文
書を参照してください。この文書には一連のチュートリアルも含まれます。

『MPLAB® IDE User’s Guide/Help』(DS51519)

MPLAB IDE (Integrated Development Environment) ソフトウェアのインストールと
機能の詳細は、この文書を参照してください。オンラインヘルプ版もあります。

『In-Circuit Serial Programmer™ (ICSP™) Guide』(DS30277)

この文書では、ICSP プログラミングを成功させるための設計ガイドラインを紹介し
ています。ハードウェア設計向けアプリケーション ノートと ICSP プログラミング
仕様も含まれます。

『MPASM™ Assembler, MPLINK™ Object Linker, MPLIB™ Object Librarian 
User’s Guide』(DS33014) 

マイクロチップ社の PIC® MCU アセンブラ (MPASM アセンブラ )、リンカ (MPLINK
リンカ )、ライブラリアン (MPLIB ライブラリアン ) の使用方法を説明しています。

PICkit™ 3 Debug Express の Readme

PICkit 3 Debug Express の使用に関する最新情報は、MPLAB IDE のインストール先
ディレクトリの Readmes サブディレクトリにある「Readme for PICkit 3.htm」
ファイル (HTML ファイル ) を参照してください。Readme ファイルには、ユーザガ
イドに反映されていない最新情報と既知の問題が記載されています。

『PICkit™ 3 Debug Express C18 Lessons』

PICkit 3 Debug Express と PIC18 MCU 用の MPLAB C コンパイラの使用方法を手順
を追って説明したチュートリアルです。MPLAB IDE の CD-ROM に収録されていま
すが、マイクロチップ社ウェブサイトからも入手できます。

Readme ファイル

その他のツールの使用についての最新情報は、MPLAB IDE のインストール先ディレ
クトリの Readmes サブディレクトリにある各ツールの Readme ファイルを参照し
てください。Readme ファイルには、ユーザガイドに反映されていない最新情報と
既知の問題が記載されています。
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序章
マイクロチップ社のウェブサイト

マイクロチップ社は、弊社が運営する WWW サイト (www.microchip.com) を通して
オンライン サポートを提供しています。このウェブサイトを活用する事で、ファイル
と情報を簡単に入手できます。お好みのインターネット ブラウザを使って、下記の内
容をご覧になれます。

• 製品サポート － データシートとエラッタ、アプリケーション ノートとサンプル プログラム、
設計リソース、ユーザガイドとハードウェア サポート文書、最新のソフトウェアと過去の
ソフトウェア

• 一般的な技術サポート － よく寄せられる質問 (FAQ)、技術サポート リクエスト、オンライン 
ディスカッション グループ、マイクロチップ社コンサルタント プログラム メンバーの一覧

• マイクロチップ社の事業 － 製品セレクタと注文のガイド、マイクロチップ社の最新プレスリ
リース、セミナーとイベントの一覧、マイクロチップ社の各営業所、販売代理店、工場の一覧

開発システムのお客様向け通知サービス

マイクロチップ社のお客様向け通知サービスにて、常にお客様にマイクロチップ社
製品の最新情報を提供いたします。ご興味のある製品ファミリまたは開発ツールに
関する変更、更新、エラッタ情報をいち早くメールにてお知らせします。

マイクロチップ社のウェブサイト www.microchip.com にアクセスし、[Customer 
Change Notification] からご登録ください。

開発システム製品のグループ カテゴリは、以下の通りです。

• コンパイラ － マイクロチップ社の C コンパイラ、アセンブラ、リンカ、その他の言語ツール
の最新情報です。これには、MPLAB C コンパイラ全製品、MPLAB アセンブラ全製品
(MPASM アセンブラを含む )、MPLAB リンカ全製品 (MPLINK オブジェクト リンカを含む )、
MPLAB ライブラリアン全製品 (MPLIB オブジェクト ライブラリアンを含む ) が含まれます。

• エミュレータ － マイクロチップ社のインサーキット エミュレータの最新情報です。これに
は、MPLAB REAL ICE、MPLAB ICE 2000 インサーキット エミュレータが含まれます。

• インサーキット デバッガ – マイクロチップ社のインサーキット デバッガに関する最新情報
です。これには、MPLAB ICD 3 インサーキット デバッガと PICkit™ 2/3 Debug Express が
含まれます。

• MPLAB® IDE － 開発システムツール向け Windows® 統合開発環境であるマイクロチップ社
の MPLAB IDE の最新情報です。これには、MPLAB IDE、MPLAB IDE プロジェクト マネー
ジャ、MPLAB エディタ、MPLAB SIM シミュレータ、一般的な編集とデバッグの機能が含
まれます。

• プログラマ － マイクロチップ社のプログラマの最新情報です。これには、MPLAB REAL 
ICE インサーキット エミュレータ、MPLAB ICD 3 インサーキット デバッガ、MPLAB PM3
デバイス プログラマ等の量産プログラマが含まれます。また、PICSTART® Plus、PICkit 
1/2/3 等、非量産向けの開発プログラマも含まれます。
 2012 Microchip Technology Inc. DS51795B_JP - p.9
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カスタマ サポート

マイクロチップ社製品のお客様は、下記のチャンネルからサポートをご利用頂けます。

• 販売代理店または販売担当者

• 各地の営業所

• フィールド アプリケーション エンジニア (FAE)

• 技術サポート

サポートは販売代理店、販売担当者、フィールド アプリケーション エンジニア
(FAE) までお問い合わせください。各地の営業所もご利用頂けます。各営業所と所
在地の一覧は、本書の巻末に記載しています。最新の営業所一覧は、弊社ウェブサ
イトでご確認ください。

技術サポートは下記のウェブサイトからもご利用頂けます : 
http://support.microchip.com

本書の内容に誤りやその他ご意見がありましたら、docerrors@microchip.com まで
メールでお寄せください。

改訂履歴

リビジョン A (2009 年 1 月 )

本書の初版

リビジョン B (2010 年 7 月 )

セクション 1.5「デバイスと機能のサポート」を削除。この内容は、MPLAB IDE の
PICkit 3 オンラインヘルプにてご確認いただけます。

セクション 2.4.4「デバッガから電源を供給する場合」の 3 番目の段落を差し換え。

セクション 2.7「プログラミング」に、デバイスのプログラム方法を 3 つ追加。

第 6 章「PICkit 3 Programmer-To-Go」を追加。

表 10-6「[Program Memory] タブのオプション」に「Use high voltage on MCLR」の
項目を追加。

セクション 10.5.8「[Settings] ダイアログの [Power] タブ」に「Power target circuit 
from PICkit 3」オプションの説明文を追加。

セクション 10.5.10「[Setting] ダイアログの [Programmer-to-go] タブ」を追加。

第 11 章「ハードウェア仕様」を「補遺 A ハードウェア仕様」に変更。
DS51795B_JP - p.10   2012 Microchip Technology Inc.
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PICkit™ 3 ユーザガイド

Chapter 1.  概要
1.1 はじめに

ここでは、PICkit 3 プログラマ / デバッガ システムの概要を説明します。

• PICkit 3 プログラマ / デバッガについて

• PICkit 3 プログラマ / デバッガの利点

• PICkit 3 プログラマ / デバッガの構成要素

1.2 PICkit 3 プログラマ / デバッガについて

PICkit 3 プログラマ / デバッガ ( 図 1-1 参照 ) はシンプルかつ低コストなインサーキッ
ト デバッガで、Windows® で動作する MPLAB IDE (v8.20 以上 ) ソフトウェアを使って
操作します。PICkit 3 プログラマ / デバッガは、開発エンジニアにとって欠かせない
ツールの 1 つです。ソフトウェアの開発からハードウェアの統合 まで、幅広い用途に
対応します。

PICkit 3 プログラマ / デバッガは、インサーキット シリアル プログラミング™ (ICSP™)
と拡張 ICSP の 2 線式シリアル インターフェイスを使って、マイクロチップ社の
PIC®MCU と dsPIC® DSC 向けのハードウェア / ソフトウェアの開発を行えるデバッ
ガシステムです。PICkit 3 プログラマ / デバッガシステムは、デバッガとしてだけで
なく開発プログラマとしても使用できます。量産プログラマとしての使用は想定して
いません。

このデバッガシステムはデバッガ専用のチップではなくエミュレーション回路を内蔵
したデバイスを使うため、実際のデバイスと同じようにコードを実行します。
ターゲット デバイスで利用できる機能は全てインタラクティブに利用でき、MPLAB 
IDE インターフェイスを利用して設定や変更が行えます。

PICkit 3 デバッガは、デバッグ機能を内蔵した組み込みプロセッサのエミュレーション
用に開発されました。PICkit 3 の主な特長は以下の通りです。

• Windows 標準ドライバでフルスピード USB をサポート

• リアルタイム実行

• プロセッサの最大動作速度でデバッグが行える

• 過電圧 / 短絡監視機能を内蔵

• 低電圧～ 5 V ( レンジ : 1.8 ～ 5 V)

• LED インジケータ (POWER、ACTIVE、STATUS)

• マイクロコントローラのプログラムメモリとデータメモリの読み書き

• 全種類のメモリ (EEPROM、ID、コンフィグレーション、プログラム ) の消去とベリファイ

• ブレークポイントでの周辺モジュールのフリーズ
 2012 Microchip Technology Inc. DS51795B_JP - p.13
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図 1-1: PICkit™ 3 MCU プログラマ / デバッガ

1.2.1 ストラップホール

プログラマ本体にストラップを取り付けて使用できます。

1.2.2 USB ポート

USB mini-B コネクタタイプの USB ポートです。付属の USB ケーブルを使って
PICkit 3 を PC に接続します。

1.2.3 1 ピンマーカー

コネクタの向きを合わせる目印として、1 ピンの位置を示しています。

1.2.4 プログラミング コネクタ

ターゲット デバイスと接続するための 6 ピンヘッダ (0.100 インチ間隔 ) です。ピン
配置は図 1-2 を参照してください。

6

21

3

4

凡例 :

1 – Lanyard Connection

2 – USB Port Connection

3 – Pin 1 Marker

4 – Programming Connector

5 – Status LEDs

6 – Push Button

5
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概要
図 1-2: PICkit™ 3 プログラマのコネクタのピン配置

1.2.5 インジケータ LED

インジケータ LED は、PICkit 3 のステータスを表示します。

1. POWER ( 緑 ) – PICkit 3 に USB ポートから電源が供給されています。

2. ACTIVE ( 青 ) – PICkit 3 が PC の USB ポートに接続されて通信リンクがアクティブです。

3. STATUS:

ビジー ( 黄 ) – プログラミング等の動作を実行中です。

エラー ( 赤 ) – エラーが発生しました。

1.2.6 プッシュボタン

このプッシュボタンは、Programmer-To-Go 機能で使用します (Chapter 6.「PICkit 3 
Programmer-To-Go」参照 )。

1.3 PICkit 3 プログラマ / デバッガの利点

PICkit 3 プログラマ / デバッガには以下の利点があります。

• 実際のハードウェアでアプリケーションをリアルタイム デバッグできる

• ハードウェア ブレークポイント使ってデバッグできる

• 内部イベントに基づいたブレークポイントが設定できる

• 内部ファイルレジスタを監視できる

• フルスピードでエミュレートできる

• デバイスがプログラムできる

1
2
3
4
5
6

* 6 ピンヘッダ (0.1 インチ間隔 ) は 0.025 インチ角型ピンに適合します。

Pin Description*

1 = MCLR/VPP

2 = VDD Target

3 = VSS (ground)

4 = PGD (ICSPDAT)

5 = PGC (ICSPCLK)

6 = PGM (LVP)

Pin 1 Indicator

Note: シリアル EEPROM デバイスのプログラミング時は、プログラミング コネ
クタのピン機能が異なります。ピン配置の詳細は、MPLAB IDE に付属して
いる PICkit 3 の ReadMe ファイル ([Help]>[Readme]) を参照してください。
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1.4 PICkit 3 プログラマ / デバッガの構成要素

PICkit 3 プログラマ / デバッガシステムには以下のものが含まれます。

1. PICkit 3 (POWER、ACTIVITY、STATUS インジケータ付き )

2. USB ケーブル ( デバッガと PC 間の通信と、デバッガへの電源供給用 )

3. MPLAB IDE ソフトウェアと文書を収録した CD-ROM

図 1-3: デバッガシステムの構成要素

この他、以下のオプションもご購入頂けます。

• 以下を含む PICkit 3 Debug Express Kit:

- PIC18F45K20 MCU を実装した 44 ピン デモボード

- PIC18 MCU 用 MPLAB C コンパイラ ( 無償版 )

- 分かりやすいレッスンとチュートリアル

- その他のソフトウェア ユーティリティ、サンプルコード ( ソースコード付き )、文書一式

• 変換ソケット

• ICD ヘッダ

• MPLAB IDE プロセッサ拡張キット

PICkit™ 3

To Target Board

USB Cable to PC

Indicator
Lights
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Chapter 2.  動作原理
2.1 はじめに

ここでは、PICkit 3 プログラマ / デバッガシステムの動作のしくみについて簡単に説
明します。ここでの目的は、PICkit 3 プログラマ / デバッガシステムを使ってエミュ
レーションとプログラミングを行えるよう、ターゲットボードの設計に必要な情報
を提供する事にあります。また、万一問題が発生してもすぐに解決できるように、
インサーキット エミュレーションおよびプログラミングの基本的な動作原理につい
ても説明します。

• PICkit 3 と PICkit 2 の違い

• デバッガとターゲットの通信

• 通信の接続

• デバッグ

• デバッグのための要件

• プログラミング

• デバッガが使うリソース

2.2 PICkit 3 と PICkit 2 の違い

PICkit 3 プログラマ / デバッガシステムは、PICkit 2 インサーキット デバッガシステ
ムと多くの点で似ています。これら 2 つのデバッガの似ている点は以下の通りです。

• PC から USB ケーブルで電源を供給する

• 供給する電源電圧値を設定できる

PICkit 2 にはなく、PICkit 3 で追加された機能は以下の通りです。

• 拡張 EE プログラム イメージ空間 (512 KB)

• 正確な参照電圧

• 電圧レンジが広くなった (1.8 ～ 5 V VDD、1.8 ～ 14 V VPP)

2.3 デバッガとターゲットの通信

ここからは、デバッガシステムの構成について説明します。

標準 ICSP による通信

PICkit 3 デバッガシステムは、標準 ICSP 通信によるプログラミングとデバッグが可
能です。使用する 6 ピン接続は、PICkit 2 プログラマ / デバッガシステムで使ってい
たものと同じです。

CAUTION

PICkit 3 からターゲットに電源を供給している間はケーブル / ピンを抜き差ししないでください。
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モジュラケーブルは、(1) ターゲット デバイスがターゲットボードに直接実装されて
いる場合はターゲットの対応ソケットに挿入し ( 図 2-1)、(2) ターゲットボードに標
準のアダプタ / ヘッダボード コンボ ( プロセッサ パックとして提供 ) を接続している
場合はアダプタ / ヘッダボードのソケットに挿入します ( 図 2-2)。

標準通信の詳細は、補遺 A.「ハードウェア仕様」を参照してください。

図 2-1: 標準のデバッガシステム ― ICE 回路内蔵デバイスの場合

図 2-2: 標準のデバッガシステム ― ICE デバイスの場合

Note: 旧式のヘッダボードは 8 ピンコネクタではなく 6 ピンの RJ-11 コネクタを
使っているため、AC164110 ICSP アダプタを使ってデバッガと接続します。

Target Device

or PIM

Power

PICkit™ 3

Mini-USB

to PC 
cable

 Board

Target BoardTransition Socket

Device-ICE

AC164110
Adapter

Header

Power

PICkit™ 3

Mini-USB

to PC 
cable
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動作原理
2.4 通信の接続

2.4.1 ターゲットとの通信

2.4.1.1 シングル インライン コネクタを使う場合

6 ピンのインライン コネクタを使って PICkit 3 プログラマ / デバッガとターゲット
ボードのコネクタを接続します ( 図 2-1 参照 )。表 2-1 と A.6「標準通信ハードウェア」
も参照してください。

2.4.1.2 アダプタを使う場合

PICkit 3プログラマ /デバッガとターゲット デバイスの間にAC164110アダプタを使って、
6芯のモジュラ インターフェイス ケーブルで接続します。図 2-3 にターゲットボードの
はんだ面から見たコネクタのピン番号を示します。

図 2-3: ターゲット側の標準 RJ-11 接続部

2.4.2 ターゲットとの接続回路

図 2-4 に PICkit 3 プログラマ / デバッガとターゲットボードを接続する際の配線を示
します。この図には、コネクタからターゲットのプリント基板上のデバイスへの配線
も示されています。VPP/MCLR ラインから VDD へプルアップ抵抗 ( 通常、約 10 k)
を接続しておく事を推奨します。こうすると、このラインを Low にするとデバイス
をリセットできます。

表 2-1: ターゲット側コネクタのピン配置

コネクタのピン番号 マイクロコントローラのピン

1 MCLR/VPP

2 VDD

3 グランド

4 PGD (ICSPDAT)

5 PGC (ICSPCLK)

6 PGM (LVP)

Note: デバッガとターゲットをケーブルで接続すると、反対のピン番号どうしが
結線されます。つまり、ケーブルの片方の 1 ピンは、もう片方の 6 ピン
に接続されます。(A.6.2.3「モジュラケーブルの仕様」参照 )。

1

2

3

4

5

6

Target
Connector

Target

Bottom Side
PC BoardVPP/MCLR

Vss

PGC
VDD

PGD
LVP
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図 2-4: ターゲット回路との標準接続

2.4.3 ターゲットの自己給電

以下の説明では、1 ピン (VPP/MCLR)、5 ピン (PGC)、4 ピン (PGD) の 3 つのライン
のみがアクティブで、基本的なデバッガの動作に関係します。参考までに図 2-4 に
は、2 ピン (VDD) と 3 ピン (VSS) も示しています。PICkit 3 では、ターゲット デバイ
スの電源をデバッガから供給する構成と、ターゲット側に外付けの電源を使用する構
成の 2 種類が可能です。

ターゲット アプリケーションの外付け電源を使用する方法を推奨します。この構成
では、デバッガがターゲットの VDD を検出して、ターゲットが低電圧動作の場合に
レベル変換を実行します。デバッガが VDD ライン ( インターフェイス コネクタの 2
ピン ) の電圧を検出できない場合、デバッガは動作しません。

2.4.4 デバッガから電源を供給する場合

デバッガの内部電源は 30 mA までに制限されています。この電源供給方法は、デバ
イスの VDD が他のアプリケーション回路から分離されて独立プログラミングを行え
るようなきわめて小規模のアプリケーションには適していますが、USB バスパワー
として PC から流れる電流が大きくなるため、一般的な用途には推奨できません。

デバイスによっては AVDD ラインと AVSS ラインがない場合もありますが、これらの
ラインがターゲット デバイスにある場合、デバッガが動作するにはこれらを全て適切
なレベルに接続する必要があります。フローティングのままにする事はできません。

また、VCAP ラインのあるデバイス (PIC18FXXJ 等 ) は、適切なコンデンサまたはレ
ベルに接続する必要があります。

VDD

VPP/MCLR

PGC

PGD

VSSAVDD

AVSS

2

1

5

4

3

User Reset

4.7K-10K

Interface
Connector

Application
PC Board

Device

Note: 配線は非常にシンプルです。問題が発生する場合、これらの重要なライ
ンに他の接続または部品を取り付けているために PICkit 3 プログラマ /
デバッガの正常な動作が妨げられている場合がほとんどです。詳細につ
いては、次のセクションで説明します。
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動作原理
2.4.5 デバッガの正常動作を妨げる回路

図 2-5 は、デバッガのアクティブなラインに PICkit 3 デバッガシステムの正常動作
を妨げる部品を取り付けた様子を示したものです。

図 2-5: 不適切な回路部品

具体的には、以下のガイドラインに従う必要があります。

• PGC/PGD にプルアップ抵抗を使用しない ― これらのラインはデバッガ内部に 4.7 kのプ
ルダウン抵抗があるため、プルアップ抵抗を使用すると電圧レベルが低下します。

• PGC/PGD にコンデンサを使用しない ― コンデンサを使用すると、プログラミングとデバッ
グの通信の際にデータ / クロックラインの高速遷移が妨げられます。

• MCLR にコンデンサを使用しない ― VPP の高速遷移が妨げられます。通常、シンプルなプ
ルアップ抵抗で十分です。

• PGC/PGD にダイオードを使用しない ― デバッガとターゲット デバイスの双方向通信が行
えなくなります。

2.5 デバッグ

PICkit 3 プログラマ / デバッガシステムをデバッガとして使用するには、2 段階の手順
があります。まず、アプリケーションをターゲット デバイスにプログラムします
( 通常は PICkit 3 をプログラマとして使います )。次に、ターゲットのフラッシュ デバ
イスに内蔵されたインサーキット デバッグ ハードウェアを使ってアプリケーション 
プログラムを実行、テストします。この 2 つの手順は、MPLAB IDE での以下の操作
に対応しています。

1. コードをターゲット デバイスにプログラムし、専用のデバッグ機能を有効にする ( 次セク
ション参照 )。

2. デバッガを使ってブレークポイントを設定し、実行する。

ターゲット デバイスに正しくプログラムできないと、PICkit 3 プログラマ / デバッガ
でデバッグが行えません。

図 2-6 に、プログラミングに必要な基本の配線を示します。これは図 2-4 と同じも
のですが、分かりやすくするためにデバッガの VDD ラインと VSS ラインは省略して
います。

No!

No!

No!

No!

VPP/MCLR

PGC

PGD

1

5

4

Interface
Connector
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図 2-6: プログラミング時の正しい接続 

この図は、PICkit 3 プログラマ / デバッガの内部インターフェイス回路の一部を簡単
に示したものです。プログラミング時はターゲット デバイスにクロックは不要です
が、電源は供給する必要があります。プログラミングを行う際、デバッガは
VPP/MCLR をプログラミング レベルにし、PGC にクロックパルス、PGD にシリアル
データを送出します。ターゲット デバイスへのプログラムが正しく完了した事を確
認するために、PGC にクロックを送出し、PGD からデータを読み出します。これは、
ターゲット デバイスの ICSP プロトコルに従って行われます。

2.6 デバッグのための要件

PICkit 3 プログラマ / デバッガシステムでデバッグ ( ブレークポイントの設定、レジス
タの参照等 ) を行うために、正しく実施する必要のある重要な項目は以下の通りです。

• デバッガが PC に接続されている必要があります。USB ケーブルを利用して PC からデバッ
ガに電源を供給する事、USB ケーブルを利用して MPLAB IDE ソフトウェアとデバッガが通
信を行う事が必要です ( 詳細は Chapter 3.「インストール」参照 )。

• 図に示したように、モジュラ インターフェイス ケーブル ( または同等品 ) を使ってデバッガ
がターゲット デバイスの VPP、PGC、PGD ピンに接続されている必要があります。VSS と
VDD もデバッガとターゲット デバイスの間で接続しておく必要があります。

• ターゲット デバイスに電源が供給されており、オシレータが正しく動作している必要があり
ます。何らかの理由でターゲット デバイスが動作しない場合、PICkit 3 プログラマ / デバッガ
でデバッグを行う事はできません。

• ターゲット デバイスのコンフィグレーション ワードが以下に示すように正しくプログラム
されている必要があります。

- ターゲットの設計に応じてオシレータのコンフィグレーション ビットを RC、XT 等に正
しく設定しておく必要があります。

- ウォッチドッグ タイマが既定値で有効になっているデバイスでは、無効にしておく必要が
あります。

- ターゲット デバイスのコード保護は無効にしておく必要があります。

- ターゲット デバイスのテーブル読み出し保護は無効にしておく必要があります。

• PGM (LVP) は無効にしておく必要があります。

上記の条件が満たされている事を確認したら、次の項に進んでください。

• デバッグ開始までの操作手順

• デバッグの詳細
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動作原理
2.6.1 デバッグ開始までの操作手順

前セクションでデバッグ実行のための要件に記載した要件が満たされている場合、
MPLAB IDE のメニューで [Debugger]>[Select Tool]>[PICkit 3] の順に選択し、現在の
デバッガとして PICkit 3 プログラマ / デバッガを設定すると、以下の操作が実行でき
ます。

• [Project]>[Build Configuration]>[Debug] の順に選択し、アプリケーション コードをコンパイ
ル / アセンブルする。

• [Debugger]>[Program] の順に選択し、前述の ICSP プロトコルを利用してアプリケーション 
コードをデバイスのメモリに書き込む。

• MPLAB IDE によって、サイズの小さい「デバッガ実行プログラム」がターゲット デバイス
のプログラムメモリの上位領域に自動的に読み込まれる。デバッガ実行プログラムはプログ
ラムメモリに常駐する必要があるため、アプリケーション プログラムはこの予約領域を使
用する事はできません。一部のデバイスには、デバッガ実行プログラム専用のメモリ領域が
用意されたものもあります。詳細はデバイスのデータシートで確認してください。

• ターゲット デバイスの「インサーキット デバッグ」専用レジスタが有効になる。これにより、
デバッガからデバッガ実行プログラムを有効にする事ができます。

• VPP/MCLRラインを Lowに保つ事によって、ターゲット デバイスはリセット状態に保持される。

2.6.2 デバッグの詳細

図 2-7 に、デバッグの準備が完了した PICkit 3 プログラマ / デバッガシステムを示し
ます。

図 2-7: デバッグの準備が完了した PICkit™ 3 デバッガ

一般に、アプリケーション プログラムが正しく動作するかどうかを確認するには、
プログラムコードの最初の方にブレークポイントを設定します。MPLAB IDE のユーザ 
インターフェイスでブレークポイントを設定すると、そのアドレスがターゲット デバ
イス内部のデバッグ専用レジスタに保存されます。PGC と PGD に対するコマンド
は、これらのレジスタと直接通信してブレークポイントのアドレスを設定します。

次は通常、MPLAB IDE で [Debugger]>[Run] の順にクリックするか、または [Run]
アイコン ( 右向きの矢印 ) をクリックします。すると、デバッガからの命令によって
デバッガ実行プログラムが実行されます。ターゲットはリセットベクタから動作を
開始し、プログラム カウンタが内部デバッグレジスタに保存されたブレークポイン
トのアドレスに達すると実行が停止します。

ブレークポイントのアドレスの命令が実行されると、割り込みと同じようなメカニズ
ムでターゲット デバイスのインサーキット デバッグ メカニズムが「起動」してデバ
イスのプログラム カウンタをデバッガ実行プログラムに転送し、ユーザのアプリ
ケーションは停止します。デバッガは PGC と PGD を介してデバッガ実行プログラ
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ムと通信し、ブレークポイントのステータス情報を取得して MPLAB IDE に返します。
この後、MPLAB IDE は一連の問い合わせをデバッガに送信し、ファイルレジスタの
内容や CPU の状態等、ターゲット デバイスに関する情報を取得します。これらの問
い合わせは、最終的にはデバッガ実行プログラムによって実行されます。

デバッガ実行プログラムは、プログラムメモリ内のアプリケーションとまったく同
じように動作します。一時変数を保存するためにスタックの一部を使用します。
オシレータがない、電源接続が不良、ターゲットボードの短絡等、何らかの理由でデ
バイスが動作しない場合、デバッグ実行プログラムと PICkit 3 プログラマ / デバッガ
が通信できず、MPLAB IDE にエラー メッセージが表示されます。

ブレークポイントを取得するもう 1 つの方法は、MPLAB IDE の [Halt] ボタン ([Run]
アイコンの矢印の右にある一時停止のアイコン ) をクリックする事です。すると、
PGC ラインと PGD ラインが切り換わり、ターゲット デバイスのインサーキット デ
バッグ メカニズムの働きにより、プログラム カウンタがプログラム メモリ内のユー
ザコードからデバッガ実行プログラムに切り換わります。この場合もターゲット アプ
リケーションのプログラム実行が停止し、MPLAB IDE はデバッガとデバッガ実行プロ
グラムの間で行われる通信を利用してターゲット デバイスの状態を問い合わせます。

2.7 プログラミング

PICkit 3 を使ってデバイスをプログラムするには、以下の 3 つの方法があります。

• PICkit 3 と PC を接続し、MPLAB IDE を使う。

• MPLAB IDE で設定後、PICkit 3 の Programmer-To-Go 機能を使う ( 詳細は Chapter 
6.「PICkit 3 Programmer-To-Go」参照 )。

• PICkit 3 プログラマ アプリケーション (MPLAB IDE を使用せずに PICkit 3 でデバイスをプ
ログラムするためのソフトウェア ) を利用する ( 詳細は『PICkit™ 3 Programmer 
Application User’s Guide』参照 )。

PICkit 3 プログラマ / デバッガをプログラマとして使うと、実際のデバイス ( すなわ
ち、ヘッダボードに装着された -ICE/-ICD 以外のデバイス ) に対してプログラムでき
ます。MPLAB IDE のメニューで [Programmer]>[Select Programmer] の順にクリック
して「PICkit 3」を選択した後、MPLAB IDE のツールバーで [Build Configuration] リ
ストボックスから「Release」を選択してアプリケーション コードのコンパイル / ア
センブルを実行します。または、[Project]>[Build Configuration]>[Release] の順にク
リックしても「Release」に設定できます。

デバッガをプログラマとして使う場合、デバッグ機能は全て OFF になるか解除され
ます。[Programmer]>[Program] 順に選択してデバイスをプログラムすると、MPLAB 
IDE によってインサーキット デバッグ レジスタが無効にされるため、PICkit 3 プロ
グラマ / デバッガはターゲット アプリケーション コードとコンフィグレーション 
ビット ( さらに、EEPROM 装備のデバイスで選択した場合は EEPROM データ ) の
みをターゲット デバイスにプログラムします。デバッガ実行プログラムは読み込ま
れません。プログラマとして使う場合、デバッガは MCLR ラインをトグルしてター
ゲットをリセット / 起動する事しか行えません。ブレークポイントの設定、レジスタ
内容の参照または変更はできません。

PICkit 3 プログラマ / デバッガシステムは、ICSP を利用してターゲット デバイスを
プログラムします。VPP、PGC、PGD ラインは、前述した通りに接続してください。
プログラミング時にはクロックは不要です。また、コード保護、ウォッチドッグ タ
イマ、テーブル読み出し保護を含め、プロセッサの全てのモードをプログラミングで
きます。

2.8 デバッガが使うリソース

各デバイスで PICkit 3 プログラマ / デバッガが使用するリソースの一覧は、MPLAB 
IDE のオンラインヘルプ ファイルを参照してください。
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Chapter 3.  インストール
3.1 はじめに

ここでは、PICkit 3 プログラマ / デバッガシステムのインストール方法について説明
します。

• ソフトウェアのインストール

• ターゲットの接続

• ターゲットボードの設定

• MPLAB® IDE の設定

3.2 ソフトウェアのインストール

MPLAB IDE ソフトウェアをインストールするには、まず最新の MPLAB IDE インス
トール実行ファイル (MPxxxxx.exe、xxxxxは MPLAB IDE のバージョン ) をマイク
ロチップ社のウェブサイト (www.microchip.com) からダウンロードするか、MPLAB 
IDE の CD-ROM (DS51123) を入手します。次に、このインストール実行ファイルを
実行し、画面の指示に従って MPLAB IDE をインストールします。

3.3 ターゲットの接続

PICkit 3 プログラマ / デバッガには、ターゲットとの通信方法を選択するための接続
回路が内蔵されています。詳細と接続図は、2.3「デバッガとターゲットの通信」を
参照してください。

1. USB/ 電源ケーブルを接続する。

2. デバッガとターゲットを通信ケーブルで接続する (RJ11 プラグを使う場合 )か、または 6 ピン
インラインヘッダに直接接続する。

図 3-1: 通信ケーブルと USB/ 電源ケーブルの接続

Note: PICkit 3 プログラマ / デバッガを使用するには、MPLAB IDE v8.20 以上が
必要です。

PICkit™ 3

To Target BoardUSB Cable to PC
or Header

21
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D

3.4 ターゲットボードの設定

3.4.1 量産デバイスを使う場合

量産デバイスを使う場合、デバッガをターゲットボードに直接接続します。PICkit 3
プログラマ / デバッガでエミュレーションを行うには、ターゲットボード上のデバイ
スがデバッグ回路を内蔵している必要があります。必要なデバッグ回路を内蔵してい
るかどうかは、各デバイスのデータシートで確認してください ( デバッグ回路を内蔵
するデバイスには「バックグラウンド デバッガ イネーブル」コンフィグレーション 
ビットがあります )。

ターゲットボードには、デバッガで使用する通信方法に対応したコネクタが必要で
す。接続の詳細は、2.3「デバッガとターゲットの通信」の「標準 ICSP による通信」
を参照してください。

3.4.2 ICE デバイスを使う場合

ICE デバイスを使う場合、ICE ヘッダボードが必要です。このヘッダボードは、特定
のデバイスまたはデバイスファミリのエミュレーションに必要なハードウェアを実装
しています。ICE ヘッダの詳細は、『Header Board Specification』(DS51292) を参照
してください。

ICE ヘッダをターゲットボードに接続するには、変換ソケットを使用します。共通
のヘッダを各種の表面実装パッケージに接続できるように、各種変換ソケットを用
意しています。変換ソケットの詳細は、『Transition Socket Specification』(DS51194)
を参照してください。

ヘッダボードのレイアウトは、ヘッダまたはプロセッサ拡張パックごとに異なります。
接続の詳細は、2.3「デバッガとターゲットの通信」の「標準 ICSP による通信」を参
照してください。

3.4.3 ICD ヘッダを使う場合

PIC MCU のベースライン全製品と一部のミッドレンジ製品の場合、デバッグ機能を
利用するには特別な「–ICD」デバイスを実装したデバッグ ヘッダボードが必要です。
これらのデバイスの種類と必要な ICD ヘッダボードの製品番号は、『Header Board 
Specification』(DS51292) を参照してください。ヘッダボードの仕様は PICkit 3 の
CD-ROM に収録している他、オンライン (www.microchip.com) でも公開しています。

ICD ヘッダボードは「–ICD」デバイスを実装しており、量産デバイスの代わりに
ターゲットボードで使用します。しかし、ほとんどのヘッダボードにはデバッグ用
の RJ-11 コネクタが付いており、RJ-11/ICSP アダプタキット (AC164110) を使って
PICkit 3 に接続します。図 3-2 に、PIC18F45K20 の ICD ヘッダ (AC162061) と
AC164110 アダプタキット、少ピン デモボードを使った場合の接続を示します。

Note: 将来的には、ICD をサポートする回路を内蔵したデバイスも使用可能に
なる予定です。

Note: 将来的には、ICD デバイス ( デバイス名 -ICD) を搭載した ICD ヘッダ
ボードも使用可能になる予定です。
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図 3-2: ICD ヘッダボードの使用

多くのミッドレンジ製品、PIC18、16 ビット製品には ICD ヘッダは不要です。ICSP 
プログラミング接続で直接デバッグが行えます。

3.4.4 ターゲットへの電源供給

以下に、電源供給方法に関する要点を記します。

• USB 接続を使う場合、PICkit 3 の電源は PC から供給できますが、電流量に制限があり、小型
のターゲットボードに最大 30 mA (VDD 1.8 ～ 5 V) しか供給できません。

• 推奨するのは、ターゲットで VDD を自給する方法です。この方法だと、より大きな電流が
得られます。もう 1 つの利点として、プラグ & プレイによるターゲット検出機能が継承さ
れる点が挙げられます。つまり、MPLAB IDE がターゲットとデバイスを検出すると、その
内容が [Output] ウィンドウに表示されます。

PICkit 3 とターゲットを適切なケーブルで接続します (3.3「ターゲットの接続」参照 )。
次に、ターゲットの電源を投入します。PICkit 3 からターゲットに電源を供給する場
合、10.5.8「[Settings] ダイアログの [Power] タブ」の説明を参照してください。

3.5 MPLAB® IDE の設定

ハードウェアを接続して電源を投入したら、MPLAB IDEでPICkit 3プログラマ /デバッガ
を使用できるように設定します。

一部のデバイスでは、コンフィグレーション ビットで通信チャンネルを選択する必要
があります (PGC1/EMUC1、PGD1/EMUD1 等 )。ここで選択したピンが、デバイスに
物理的に接続されているピンと同じである事を確認してください。

プロジェクトを設定して PICkit 3 の使用を開始する手順については、Chapter 4.「全般
的な設定」を参照してください。

Note: ターゲット電圧は、ICSP インターフェイスのドライバに対してのみ電源
を供給します。PICkit 3 には電源供給を行いません。PICkit 3 の電源は
USB ポートからのみ供給されます。
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Chapter 4.  全般的な設定
4.1 はじめに

ここでは、PICkit 3 プログラマ / デバッガで作業を始める方法を説明します。

• MPLAB IDE ソフトウェアの起動

• プロジェクトの作成

• プロジェクトの表示

• プロジェクトのビルド

• コンフィグレーション ビットの設定

• デバッガまたはプログラマとしての設定

• デバッガ / プログラマの制約

4.2 MPLAB IDE ソフトウェアの起動

MPLAB IDE ソフトウェアのインストールが完了したら (3.2「ソフトウェアのインストー
ル」)、以下のいずれかの方法で起動します。

• [ スタート ]>[ すべてのプログラム ]>[Microchip]>[MPLAB IDE vx.xx]>[MPLAB IDE] の順に選
択する (「vx.xx」はバージョン番号 )。

• デスクトップにある MPLAB IDE のアイコンをダブルクリックする。

• MPLAB IDE のインストール先ディレクトリの mplab ide\coreサブディレクトリにある
mplab.exeを実行する。

MPLAB IDE ソフトウェアの使用方法の詳細は以下の文書を参照してください。

•『MPLAB® IDE User's Guide』(DS51519) ― MPLAB IDE の使用法を詳しく解説したガイド
です。

• オンラインヘルプ ファイル – MPLAB IDE と PICkit 3 プログラマ / デバッガに関する最新情
報を記載しています。

• Readme ファイル ― 各リリース直前に発生した情報を Readme for MPLAB IDE.txtと
Readme for PICkit 3 Debugger.txtに記載しています。これらのファイルは、どち
らも MPLAB IDE のインストール先ディレクトリの Readmesサブディレクトリにあります。

4.3 プロジェクトの作成

新規プロジェクトを簡単に作成するには、[Project]>[Project Wizard] の順にクリック
してプロジェクト ウィザードを使用します。プロジェクト ウィザードの指示に従って
操作すると、新規プロジェクトを作成し、そのプロジェクトのビルドに使用する言語
ツールを選択できます。ウィザードの手順に従ってソースファイル、ライブラリ等を
追加すると、プロジェクト ウィンドウの各種「ノード」に追加されます。ウィザード
の使用方法の詳細は MPLAB IDE のマニュアルを参照してください。基本的な手順は
以下の通りです。

• デバイスを選択する ( 例 : PIC18F45K20)。

• 言語ツールスイートを選択する (Microchip C Compiler Toolsuite 等 )。

• プロジェクト名を指定する。

• アプリケーション ファイルを追加する (program.c、support.s、counter.asm等 )。

Note: プロジェクトにカスタム リンカスクリプトがない場合、プロジェクト 
マネージャによって適切なリンカスクリプトが自動的に選択されます。
 2012 Microchip Technology Inc. DS51795B_JP - p.29



PICkit™ 3 ユーザガイド
4.4 プロジェクトの表示

プロジェクト ウィザードによるプロジェクトの作成が完了すると、プロジェクトと関
連ファイルがプロジェクト ウィンドウに表示されます。プロジェクト ウィンドウでツ
リーの任意の行を右クリックするとショートカット メニューが表示され、ファイルの
追加や削除を行えます。

プロジェクト ウィンドウの使用方法の詳細は MPLAB IDE のマニュアルを参照して
ください。

4.5 プロジェクトのビルド

プロジェクトを作成したら、アプリケーションをビルドする必要があります。ビルドを
行うと、アプリケーションのオブジェクト (hex) コードが作成されます。このオブジェ
クト コードを、PICkit 3 プログラマ / デバッガを使ってターゲットに書き込みます。

ビルドのオプションを設定するには、[Project]>[Build Options]>[Project] の順にクリッ
クします。

設定が完了したら、[Project]>[Build All] の順にクリックしてプロジェクトをビルドし
ます。

4.6 コンフィグレーション ビットの設定

デバイスのコンフィグレーション ビットはコード中でも設定できますが、MPLAB 
IDE の [Configuration Bits] ウィンドウで設定する事もできます。
[Configure]>[Configuration Bits] の順にクリックします。[Settings] 欄の文字列をク
リックすると、設定を変更できます。

ここでは、いくつかのコンフィグレーション ビットについて簡単に説明します。

• Watchdog Timer Enable – ほとんどのデバイスでウォッチドッグ タイマは初期状態で有効
です。通常は、このビットを無効にしておくとよいでしょう。

• Comm Channel Select – 一部のデバイスでは、デバイスの通信チャンネルを選択する必要
があります ( 例 : PGC1/EMUC1、PGD1/EMUD1)。ここで選択したピンが、デバイスに物理
的に接続されているピンと同じである事を確認します。

• Oscillator – ターゲットのオシレータと同じ設定を選択します。

4.7 デバッガまたはプログラマとしての設定

PICkit 3 プログラマ / デバッガをデバッガとして選択するには、[Debugger]>[Select 
Tool]>[PICkit 3] の順にクリックします。デバッガを選択すると、[Debugger] メニュー
と MPLAB IDE のツールバーにはデバッガの機能が表示されます。また、[Output]
ウィンドウが開き、[PICkit 3] タブに PICkit 3 のステータスおよび通信に関するメッ
セージが表示されます。詳細は、10.2「デバッグに関する機能」と 10.3「デバッグに
関するダイアログ / ウィンドウ」を参照してください。

PICkit 3 プログラマ / デバッガをプログラマとして選択するには、
[Programmer]>[Select Programmer]>[PICkit 3] の順にクリックします。プログラマを
選択すると、[Programmer] メニューと MPLAB IDE のツールバーにはプログラマの
機能が表示されます。また、[Output] ウィンドウが開き、[PICkit 3] タブに ICE のス
テータスおよび通信に関するメッセージが表示されます。詳細は、10.4「プログラミ
ングに関する機能」を参照してください。

オプションの設定は、[Debugger]>[Settings] または [Programmer]>[Settings] の順に
クリックして [Settings] ダイアログ (10.5「[Settings] ダイアログ」) で行います。

Note: PICkit 3 をデバッガとして使う場合、プロジェクト マネージャ ツールバー
([View]>[Toolbars]>[Project Manager]) のドロップダウン リストで
「Debug」を選択し、プログラマとして使う場合、「Release」を選択します。
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エラーが発生した場合、以下を参照してください。

• Chapter 9.「エラーメッセージ」

• Chapter 8.「よく寄せられる質問 (FAQ)」

4.8 デバッガ / プログラマの制約

個別のデバイスに対するデバッガの制約については、MPLAB IDE の PICkit 3 オンラ
イン ヘルプ ファイルを参照してください ([Help]>[Topics]>[PICkit 3] の順にクリック
して、[OK] をクリック )。
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Chapter 5.  PICkit 3 Debug Express
5.1 はじめに

PICkit 3 Debug Express キットを MPLAB IDE アプリケーションと組み合わせると、
プログラムの実行、停止、シングルステップ実行を行えます。複数のブレークポイ
ントの設定、プロセッサのリセットも可能です。プロセッサを停止させて、レジス
タの内容を確認 / 変更する事もできます。

MPLAB IDE の使用方法の詳細は、以下のマニュアルを参照してください。

•『MPLAB® IDE User’s Guide』(DS51519)

• MPLAB® IDE オンラインヘルプ

5.2 PICkit 3 DEBUG EXPRESS キットの内容

PICkit 3 Debug Express キット (DV164131) には、以下のものが含まれます。

1. PICkit 3 プログラマ / デバッガ

2. USB ケーブル

3. デバイス実装済みの 44 ピン デモボード *
4. MPLAB IDE CD-ROM

5. PICkit 3 Debug Express C18 のレッスン (CD-ROM 収録のチュートリアル )

* Explorer 16 ボードを使用したデバッグも可能です。

5.3 ハードウェアとソフトウェアのインストール

PICkit 3 のハードウェアとソフトウェアをまだインストールしていない場合、
Chapter 3.「インストール」の手順に従ってインストールします。

5.3.1 予約リソース

ICD デバイス内蔵のインサーキット デバッグ機能とデバッガの ICSP 機能を使うた
め、PICkit 3 Debug Express はデバッグ実行時、内部リソースの一部を使います。

インサーキット デバッグ時に必要なデバイスリソースの詳細は、MPLAB IDE のメ
ニューで [Help]>[Topics] の順に選択して、MPLAB PICkit 3 ヘルプで見る事ができま
す。「Resources Used By MPLAB PICkit 3」の項に記載されているデバイスの予約リ
ソースを PICkit 3 Debug Express も使用します。

5.3.2 デモボードの接続

44 ピン デモボードに実装されている PIC18F45K20 は、図 5-1 に示すようにデモ
ボードを PICkit 3 に接続するだけでデバッグできます。

Note: PICkit 3 Debug Express を使用するには、MPLAB IDE バージョン 8.20 以上
が必要です。
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図 5-1: デモボードと PICkit™ 3 の接続

5.3.3 コンフィグレーション ビットと Debug Express

ICD ヘッダなしで直接デバッグが可能な PIC マイクロコントローラには、コンフィ
グレーション ワードに DEBUG ビットがあり、このビットで PIC マイクロコント
ローラのデバッグモードの有効 / 無効を切り換えます。

MPLAB IDE で PICkit 3 Debug Express を使う場合、このビットは自動的にセットさ
れるため、ソースコードのコンフィグレーション設定では明示的に指定しないでく
ださい。

PIC24 や dsPIC33 ファミリ等、多くの 16 ビット PIC マイクロコントローラには、複
数の ICSP プログラミング / デバッグポート ピン (PGC1/EMUC1 と PGD1/EMUD1、
PGC2/EMUC2 と PGD2/EMUD2 等 ) があります。プログラミングの場合は任意の
ICSP ポートを使用できますが、デバッグの場合は一度にある 1 つのポートだけが
アクティブになります。このアクティブな EMU ポートはデバイスのコンフィグレー
ション ビットで設定します。アクティブポートの設定が、PICkit 3 が接続されている
EMU ポートに一致していないと、デバイスはデバッグモードに移行できません。
MPLAB IDE の [Configuration Bits] ダイアログでは、これらのビットを [Comm 
Channel Select] ビットと表示します。

CAUTION

通常は、DEBUG コンフィグレーション ビットの値をソースコードのコンフィグレーション

設定で指定しないでください。指定すると、このデバッガ以外でデバイスをプログラムする
際にこのビットがアサートされる可能性があります。このビットがアサートされるとアプリ
ケーション回路でデバイスが正しく動作しないか、または全く動作しなくなります。
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Chapter 6.  PICkit 3 Programmer-To-Go
6.1 はじめに

PICkit 3 Programmer-To-Go を使うと、PIC MCU のメモリイメージを PICkit 3 本体に
ダウンロードして、後で PIC MCU にプログラムできます。つまり、この機能を使う
とソフトウェアまたは PC がなくてもデバイスをプログラムできます。必要なのは
PICkit 3 の USB 電源のみです。

本セクションでは、以下の内容について説明します。

• PICkit 3 Programmer-To-Go の USB 電源

• PICkit 3 Programmer-To-Go 対応デバイス

• PICkit 3 で Programmer-To-Go 機能を使うための設定

• PICkit 3 の Programmer-To-Go 機能の使い方

• Programmer-To-Go モードの終了

6.2 PICkit 3 PROGRAMMER-TO-GO の USB 電源

PICkit 3 プログラマ ハードウェアは、ターゲットの ICSP コネクタの VDD ピンから
供給される電源だけでは動作しません。従って、PICkit 3 本体上部の USB mini-B
ポートから 5 V 電源を供給する必要があります。これには、以下のようにいくつか
の方法があります。

• PC の USB ポートまたは USB ハブのポート  ( バスパワーのみ使用、USB 通信は不要 )

• 携帯型機器の USB ホストポート

• USB mini-B コネクタ対応の USB 電源アダプタ / 充電器 ( 自動車のシガレット ライター電源
または家庭用コンセントから給電 )

• 携帯電話 / モバイル機器用の USB mini-B コネクタ出力付きポータブル充電器 / 電源

• レギュレートされた 5 V を PICkit 3 の USB ポートに供給するカスタム バッテリパック

6.2.1 電源要件

使用する USB 電源は以下の最小条件を満たす必要があります。

• PICkit 3 に 100 mA 以上の電流を供給できる事

• レギュレートされた 4.5 ～ 5.5 V の電圧を安定的に出力できる事

Note: PICkit 3 にはプログラマとデバッガの機能がありますが、
Programming-To-Go 機能を利用する場合はプログラマの機能のみが利用
できます。Programming-To-Go ではデバッグ機能は利用できません。

Note 1: ほとんどのバッテリ内蔵型のポータブル充電器 / 電源は、内部のバッテリ
電圧が低下して出力電圧が 4.5 V を下回った時にその事を示す手段があり
ません。従ってバッテリの残り容量には十分注意し、PICkit 3 に必ず 4.5 V
以上の電圧が供給されるようにしてください。

2: バッテリ駆動型の電源は使用しない時は PICkit 3 から外しておきます。
PICkit 3 に接続したままにしておくとバッテリが消耗します。
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6.3 PICkit 3 PROGRAMMER-TO-GO 対応デバイス

下記のファミリのうち、PICkit 3 と MPLAB IDE がサポートするデバイスは全て
Programmer-To-Go 機能に対応しています。表 6-1 に、サポートされるデバイス
ファミリとそれぞれのプログラムメモリの制約を示します。

表 6-1: PROGRAMMER-TO-GO 対応デバイス

デバイスファミリ 対応デバイス

ベースライン 全て 1

ミッドレンジ 全て 1

PIC18F 全て 1

PIC18 J シリーズ 全て 1

PIC18 K シリーズ 全て 1

PIC24 全て 1,2

dsPIC33 全て 1,2

dsPIC30 全て 1

dsPIC30 SMPS 全て 1

PIC32MX 全て 3

Note 1: このファミリのうち、MPLAB IDE でサポートされているデバイスは全
てサポートされます。MPLAB IDE でサポートされているデバイスの一
覧は、メニューで [Help]>[ReadMe] の順にクリックして確認してくだ
さい。メモリ容量の大きいデバイスはサポートされています。

2: PICkit 3 の Programmer-To-Go 機能では、これらのデバイスの拡張
ICSP (Programming Executive) は使用できません。これらのデバイス
で PICkit 3 の Programmer-To-Go 機能を利用する場合、通常の ICSP
でプログラミングが行われます。

3: MPLAB IDE v8.53 以上でサポートされています。
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6.4 PICkit 3 で PROGRAMMER-TO-GO 機能を使うための設定

メモリイメージを PICkit 3 にダウンロードして Programmer-To-Go 機能を利用する前
に、PICkit 3 プログラマのソフトウェア オプションとバッファを Programmer-To-Go
用に設定する必要があります。実際には、必要なオプションを全て設定してまずソフ
トウェアからターゲット デバイスにプログラミングを実行し、デバイスに正しくプ
ログラミングが行える事を確認してから Programmer-To-Go 用にイメージをダウン
ロードする事を推奨します。MPLAB IDE と PICkit 3 を使ってデバイスをプログラム
する方法については、＝ Chapter 4.「全般的な設定」を参照してください。

6.4.1 [PICkit 3 Settings] ダイアログの [Programmer to go] タブ

MPLAB IDE のメニューで [Programmer]>[Programmer to go Tab] の順に選択します
( 図 6-1)。

図 6-1: [PICkit 3 SETTINGS] ダイアログの [PROGRAMMER TO GO]
タブ

• [Image Name] フィールドには、プログラミング イメージに使う名前を入力します。

• [Programmer Setting Report] パネルには、デバイスのプログラミングに関して選択した設定
が表示されます。設定の変更は、[PICkit 3 Settings] ダイアログの対応するタブで行います。

• [Send Image In Memory] をクリックすると、PICkit 3 へのイメージ転送が始まります。
イメージが PICkit 3 に格納されたら、MPLAB IDE または PC がなくてもデバイスをプログ
ラムできます。PICkit 3 のボタンを押すだけです。

6.4.2 PICkit 3 へのダウンロードの完了

[Send Image In Memory] をクリックした後、ダウンロードが完了すると [Output]
ウィンドウにメッセージ ( 図 6-2) が表示されます。PICkit 3 本体の「ACTIVE」LED
が点滅していれば、Programmer-To-Go モードへの移行が完了して書き込み準備が
整った事を示します。
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図 6-2: ダウンロードの完了

PCのUSBポートからPICkit 3を取り外します。次にUSB ケーブルからPICkit 3に電源
を供給すると「ACTIVE」LEDが 1回点滅します。これは、PICkit 3がProgrammer-To-Go
で起動した事を示します。

6.5 PICkit 3 の PROGRAMMER-TO-GO 機能の使い方

PICkit 3 で Programmer-To-Go 機能を使うための設定が完了したら、以下の手順で
ターゲット デバイスをプログラムします。

1. 6.2「PICkit 3 Programmer-To-Go の USB 電源」で説明した方法で、PICkit 3 に USB 電源
を接続する。

2. PICkit 3本体の「POWER」LEDが点灯している事を確認する。PICkit 3がProgrammer-To-Go
モードになり、プログラムする準備が完了すると、「ACTIVE」LED が 1 回点滅する。

3. PICkit 3 の ICSP コネクタをターゲットに接続する。PICkit 3 から電源を供給しない場合、
ターゲットに適切に電源が供給されている事を確認する。

4. PICkit 3 のプッシュボタンを押すと、プログラム動作が開始する。

プログラム動作中は、PICkit 3 の「STATUS」LED がオレンジ色に変わり、動作が終
了するまで常時点灯します。

プログラム動作が終了すると、PICkit 3 の LED がエラーの有無を示します。成功し
た場合は「STATUS」LED が緑に点灯します。プログラムエラーがあった場合は赤
に点灯します。表 6-2 に LED 表示と意味を示します。
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表 6-2: PROGRAMMER-TO-GO 動作後の LED 表示と意味

LED のステータス 意味

ACTIVE LED STATUS LED 意味 説明

1 回点滅 ( 青 ) 緑 成功 / 準備完了 プログラム動作中にエラーは発
生しませんでした。PICkit 3 の
Programmer-To-Go 機能で再度
書き込みが可能です。

消灯 赤 – 間隔をあけず繰
り返し点滅 :
••••••••......

VDD/VPP エラー PICkit 3 が VDD または VPP の電
圧を所定の値に設定できません
でした。PICkit 3 が VDD を供給
していない場合、VPP エラーで
す。VDD と VPP の詳細は、
2.4「通信の接続」と 3.4.4「ター
ゲットへの電源供給」を参照し
てください。

消灯 赤 – 2 回ずつ繰り返
し点滅 :
•• •• •• ••.......

デバイス ID エラー PICkit 3 がターゲットから予測し
ないデバイス ID を受信しまし
た。PICkit 3 の
Programmer-To-Go 設定時に選
択したデバイスとターゲット デ
バイスが一致する事を確認しま
す。ICSP 接続に問題があり、
PICkit 3 がターゲットと通信でき
ていない可能性もあります。
ベースライン デバイスではこの
エラーは発生しません。

消灯 赤 – 3 回ずつ繰り返
し点滅 :
••• ••• •••......

ベリファイエラー プログラム後にターゲットのベ
リファイに失敗しました。ター
ゲットの VDD が最小要件を満た
している事を確かめます。ベー
スライン デバイスの場合、この
エラーは ICSP 通信の問題を示す
可能性があります。

消灯 赤 – 4 回ずつ繰り返
し点滅 :
•••• ••••......

内部エラー Programmer-To-Go で予測しな
い内部エラーが発生しました。
このエラーが繰り返し発生する
場合、PICkit 3 へのダウンロード
をやり直します。

Note: PICkit 3 のプッシュボタンを押すとエラーコードがクリアされ、新しい
プログラム動作を開始できます。
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6.6 PROGRAMMER-TO-GO モードの終了

Programmer-To-Go モードを終了するには、PICkit 3 を PC の USB ポートに接続し、
MPLAB IDE と通信します。以下のメッセージが表示され、いずれかを選択します。

図 6-3: PROGRAMMER-TO-GO モードの終了

[Yes] をクリックするとイメージが保持され、[No] をクリックすると消去されます。
[No] をクリックした場合は [Output] ウィンドウに図 6-4 のようなメッセージが表示
され、Programmer-To-Go モードが終了します。

図 6-4: [OUTPUT] ウィンドウに表示される終了時のメッセージ
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Chapter 7.  トラブルシュート
7.1 はじめに

PICkit 3 プログラマ / デバッガの操作で困った事がある場合、まずこちらの内容を確認
してください。

• 最初に確認する 5 つの項目

• デバッグに失敗する主な理由

• その他の確認事項

7.2 最初に確認する 5 つの項目

1. 使用デバイスを確認してください。比較的新しいデバイスの場合、MPLAB IDE のバージョン
アップが必要となる事があります。旧バージョンの MPLAB IDE では動作確認のとれていない
デバイスがあるため、注意してください。

2. マイクロチップ社のデモボードを使っていますか。それとも自作のボードを使っていますか。
通信の接続に必要な抵抗とコンデンサに関するガイドラインが守られていますか (Chapter
2.「動作原理」参照 )。

3. ターゲットに電源が供給されていますか。30 mA を超える場合、デバッガからターゲット
に電源を供給できません。

4. USB ハブを使っていますか。ハブに電源は供給されていますか。それでも問題が解決しない
場合、ハブを使用せずデバッガを PC に直接接続してください。

5. デバッガに付属の標準通信ケーブル (RJ-11) を使っていますか。これよりも長いケーブルを
使った場合、通信エラーが起こる可能性があります。

7.3 デバッグに失敗する主な理由

1. オシレータが動作していない。オシレータに関するコンフィグレーション ビットの設定を
確認してください。

2. ターゲットボードに電源が供給されていない。電源ケーブルの接続を確認してください。

3. デバッガと PC またはターゲットボードが物理的に接続されていない。通信ケーブルの接
続を確認してください。

4. デバイスのコード保護が有効になっている。コード保護に関するコンフィグレーション
ビットの設定を確認してください。

5. Release モードでプロジェクトの再ビルドを行おうとしている。プロジェクト マネージャ
ツールバーの [Build Configuration] ドロップダウン リストで [Debug] を選択してからプロ
ジェクトを再ビルドしてください。

6. MPLAB IDE で PICkit 3 がデバッガではなくプログラマとして選択されている。

7. デバッガと PC の通信が中断された。MPLAB IDE でデバッガに再接続します。

8. ターゲット アプリケーションに破損またはエラーがある。ターゲット アプリケーション
を再ビルドしてプログラミングし直してください。その後で、ターゲットでパワーオン 
リセットを実行します。

9. 他のコンフィグレーション設定が干渉してデバッグが行えない。ターゲットがコードを
実行できないようなコンフィグレーション設定が行われていると、デバッガはコードを
デバッグモードにする事ができません。

10. デバッガは、要求された動作を常に実行できるわけではありません。例えばターゲット
アプリケーションが実行中の場合、デバッガはブレークポイントを設定できません。
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7.4 その他の確認事項

1.  一過性のエラーの場合もあります。同じ操作を繰り返してみてください。

2. プログラミングそのものに問題がある事も考えられます。プログラマモードに切り換えて、
なるべくシンプルなアプリケーション (LED 点滅プログラム等 ) でターゲットへの書き込
みテストを行ってください。このプログラムが動作しない場合、ターゲットのセットアップ
に問題がある事になります。

3. ターゲット デバイスが何らかの損傷 ( 過電流等 ) を受けた可能性があります。開発環境で
は、電子部品に悪影響が及ぶ事がよくあります。ターゲット デバイスを別のものに交換し
てみてください。

4. マイクロチップ社では、ほとんどのマイクロコントローラをサポートしたデモボードを用
意しています。PICkit 3 プログラマ / デバッガが正しく動作するかどうかを検証するには、
正常動作が確認済みのこれらのアプリケーションを使用するのも 1 つの方法です。

5. デバッガの動作原理を確認して、アプリケーションを正しくセットアップしてください
(Chapter 2.「動作原理」参照 )。

6. それでも解決しない場合はマイクロチップ社までお問い合わせください。
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Chapter 8.  よく寄せられる質問 (FAQ)
8.1 はじめに

ここでは、PICkit 3 プログラマ / デバッガシステムについてよく寄せられる質問とその
回答を紹介します。

• 動作に関する FAQ

• 不具合に関する FAQ

8.2 動作に関する FAQ

• PICkit 3 プログラマ / デバッガは通信にデバイス内のどの機能を利用しているので
すか。

PICkit 3 プログラマ / デバッガは、ICSP インターフェイスを介してフラッシュ 
デバイスと通信します。そして、プログラムメモリまたはテストメモリにダウン
ロードしたデバッガ実行プログラムを使います。

• デバッガ実行プログラムを動作させるとプロセッサのスループットにどのような
影響がありますか。

デバッガ実行プログラムは実行モードでは動作しないため、コード実行時にスルー
プットの低下はありません。つまり、デバッガがターゲット デバイスの実行サイク
ルを「奪う」事はありません。

• PICkit 3 プログラマ / デバッガと他のインサーキット エミュレータ / デバッガに
はどのような違いがありますか。

2.2「PICkit 3 と PICkit 2 の違い」を参照してください。

• MPLAB ICE 2000/4000 デバッガでは、データに対して複雑なトリガを実行するに
はそのデータをバスに転送する必要があります。PICkit 3 プログラマ / デバッガで
もその必要がありますか。例えば、フラグが High になった時に停止する事はで
きますか。

MPLAB ICE 2000/4000 デバッガは、専用のデバッガチップ (-ME) を使って監視を行
います。PICkit 3 プログラマ / デバッガには -ME チップはないため、外部からバス
を監視する事はありません。PICkit 3 プログラマ / デバッガでは、外部ブレークポ
イントを使用するのではなく、デバッグエンジンに内蔵されたブレークポイント回
路を使用します。つまりバスとブレークポイント ロジックはデバイス内部で監視
します。

• PICkit 3 プログラマ / デバッガでは MPLAB ICE 2000/4000 のように複合ブレーク
ポイントを利用できますか。

いいえ。しかし、特定のデータメモリ アドレスに格納された値またはプログラム 
アドレスに基づいてブレークを実行する事はできます。詳細は、
10.3.1「[Breakpoints] ダイアログ」を参照してください。

• PICkit 3 は光学的または電気的に絶縁されていますか。

いいえ。現在のシステムにフロート電圧または高電圧 (120V) を印加する事はで
きません。
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• 標準ケーブルには何か制約はありますか。

標準の ICSP RJ-11 ケーブルは、15 Mbps を超えるクロック速度には対応してい
ません。

• PICkit 3 によってプログラムの実行速度は低下しますか。

いいえ。デバイスはデータシートの仕様通りの速度で動作します。

• dsPIC DSC を任意の速度で動作させてデバッグを行う事はできますか。

PICkit 3 は、デバイスのデータシートに記載されている任意の速度でデバイスを
動作させてデバッグを実行できます。

• 6 ピン (LVP ピン ) はどのような働きをしますか。

6 ピンは、LVP (Low-Voltage Programming) 接続用に予約されています。

8.3 不具合に関する FAQ

• PC が省電力 / 休止モードになった後、デバッガが動作しなくなりました。どう
したのでしょうか。

デバッガを ( 特にデバッガとして ) 長時間使う場合、お使いの PC のオペレーティン
グ システムの電源オプション設定画面で休止モードを無効にしておいてください。
Windows XP の場合、[ 電源オプションのプロパティ ] ダイアログ ボックスの [ 休止
状態 ] タブで [ 休止状態を有効にする ] のチェックを外します。こうすると、全ての
USB サブシステム コンポーネントで全通信を維持できます。

• 周辺モジュールに [Freeze on Halt] を設定していないのに突然フリーズしてしま
います。なぜでしょうか。

dsPIC30F/33F と PIC24F/H の場合、デバッガは周辺制御レジスタの予約ビット
( 通常は bit 14 または 5) を Freeze ビットとして使用します。レジスタ全体に書き
込みを実行した時に、このビットが上書きされた可能性があります ( このビット
はデバッグモードではユーザアクセス可能です )。

この問題を防ぐには、レジスタ全体を書き換える命令 (MOV) ではなく、アプリケー
ションで変更が必要なビットだけを書き換える命令 (BTS、BTC) を使用します。

• 16 ビットデバイスを使用中に、予期しないリセットが発生しました。どのよう
にして原因を調べれば良いでしょうか。

以下の点を確認してください。

- RCON レジスタを確認してリセット要因を調べる。

- 割り込みサービスルーチン (ISR) でトラップ / 割り込みを処理する。例えば、下記のよう
な trap.cコードを挿入する。

   void __attribute__((__interrupt__)) _OscillatorFail(void);
          :
   void __attribute__((__interrupt__)) _AltOscillatorFail(void);
          :
   void __attribute__((__interrupt__)) _OscillatorFail(void)
   {
        INTCON1bits.OSCFAIL = 0;        //Clear the trap flag
        while (1);
   }
          :
   void __attribute__((__interrupt__)) _AltOscillatorFail(void)
   {
        INTCON1bits.OSCFAIL = 0;
        while (1);
   }
          :

- アサートを使用する。
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• コードのデバッグが完了しました。デバイスをプログラムしましたが、動作しま
せん。何が原因でしょうか。

以下の点を確認してください。

- デバッガをプログラマとして選択してヘッダボードへの書き込みを行いませんでしたか。
ヘッダボードに搭載されているのは -ICE/-ICD バージョンのデバイスで、実際のデバイス
とは動作が異なる事があります。デバッガをプログラマとして使って書き込めるのは、通
常のデバイスのみです。通常のデバイスにも ICE/ICD 回路を内蔵したデバイスがありま
すが、ヘッダボードに搭載されている特殊な -ICE/-ICD デバイスとは別のものです。

- PICkit 3 をデバッガとして選択したままデバイスにプログラミングを行いませんでした
か。PICkit 3 をデバッガとして選択してプログラミングを行うと、デバッガ実行プログラ
ムがプログラムメモリに書き込まれ、デバッグ用のその他のデバイス機能がセットアップ
されます (2.6.1「デバッグ開始までの操作手順」を参照 )。完成した ( リリース用 ) コード
をプログラムする場合、PICkit 3 をプログラマに設定する必要があります。

- [Build Configuration] ドロップダウン リストまたは [Project] メニューで「Release」を選
択しましたか。完成した ( リリース用 ) コードを書き込むには、この操作が必要です。
プロジェクトを再ビルドしてデバイスにもう一度書き込みを行い、コードが動作するかど
うか試してみてください。

• この FAQ に記載されていない問題が発生しました。どうすれば良いでしょうか。

以下のセクションを参照してください。

- 2.8「デバッガが使うリソース」

- 9.2「特定の状況で表示されるエラーメッセージ」

- 9.3「一般的な対処方法」
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NOTES:
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Chapter 9.  エラーメッセージ
9.1 はじめに

PICkit 3 プログラマ / デバッガで表示されるエラーメッセージには多くの種類があり
ます。特定の状況で表示されるエラーメッセージもありますが、一般的な対処法で
解決するものもあります。

• 特定の状況で表示されるエラーメッセージ

• 一般的な対処方法

9.2 特定の状況で表示されるエラーメッセージ

以下に、PICkit 3 プログラマ / デバッガのエラーメッセージをエラーコードの番号順
に示します。

以下のエラーメッセージで「%x」(変数 )と表記された部分は、実際のエラーメッセージ
では状況に応じた文字列が表示されます。

PK3Err0001: Failed while writing to program memory. ( プログラム メモリへの書き込みに失
敗しました。)

PK3Err0002: Failed while writing to EEPROM. (EEPROM への書き込みに失敗しました。)

PK3Err0003: Failed while writing to configuration memory. ( コンフィグレーション メモリ
への書き込みに失敗しました。)

9.3.1「読み書きエラーの対処方法」を参照してください。

PK3Err0005: PICkit 3 is currently busy and cannot be unloaded at this time. 
(PICkit 3 は現在ビジーで選択を解除できません。)

PICkit 3 をデバッガまたはプログラマとしての指定から解除しようとしてこのエラーが
表示された場合、以下の解決方法を試してください。

1. デバッガが現在実行中のタスクが終了するまで待つ。その後、もう一度デバッガの選択
解除を試みる。

2. [Halt] を選択して実行中のアプリケーションを停止する。その後、もう一度デバッガ
の選択解除を試みる。

3. デバッガとPCの接続ケーブルを抜く。その後、もう一度デバッガの選択解除を試みる。

4. MPLAB IDE を終了する。

PK3Err0006: Failed while writing to user ID memory. ( ユーザ ID メモリへの書き込みに失敗
しました。)

PK3Err0007: Failed while reading program memory. ( プログラムメモリの読み出しに失敗し
ました。)

PK3Err0008: Failed while reading EEPROM. (EEPROM の読み出しに失敗しました。)

PK3Err0009: Failed while reading configuration memory. ( コンフィグレーション メモリの
読み出しに失敗しました。)

PK3Err0010: Failed while reading user ID memory. ( ユーザ ID メモリの読み出しに失敗しま
した。)

9.3.1「読み書きエラーの対処方法」を参照してください。

Note: 現時点では、エラーメッセージにエラーコードが表示されない場合があ
ります。ヘルプの [Search] タブでメッセージを検索して、強調表示され
た項目を参照してください。
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PK3Err0011: Bulk erase failed. ( バルク消去に失敗しました。)

9.3.1「読み書きエラーの対処方法」を参照してください。

それでも解決しない場合、別のデバイスで試してください。

PK3Err0012: Download debug exec failed ( デバッガ実行プログラムのダウンロードに失敗
しました。)

[Debugger] メニューから書き込みを実行しようとしてこのエラーが表示された場合、
以下の解決方法を試してください。

1. PICkit 3 をデバッガとしての指定から解除する。

2. プロジェクトを閉じて MPLAB IDE を終了する。

3. MPLAB IDE を再起動してもう一度プロジェクトを開く。

4. もう一度 PICkit 3 をデバッガとして指定し、ターゲット デバイスへの書き込みを実行
する。

それでも解決しない場合、9.3.4「インストール ファイルが破損している場合の対処方法」
を参照してください。

PK3Err0013: NMMR register write failed. (NMMR レジスタへの書き込みに失敗しました。)

PK3Err0014: File register write failed. ( ファイルレジスタへの書き込みに失敗しました。)

9.3.2「デバッガとターゲットの通信エラーの対処方法」を参照してください。

PK3Err0015: Data transfer was unsuccessful. %d byte(s) expected, %d byte(s) 
transferred. ( データ転送に失敗しました。%d バイト中、%d バイト転送されました。)

9.3.3「デバッガと PC の通信エラーの対処方法」を参照してください。

PK3Err0016: Cannot transmit. PICkit 3 not found. ( 転送できません。PICkit 3 が見つかりません。)

デバッガが PC に正しく接続されていません。

PK3Err0017: File register read failed. ( ファイルレジスタの読み出しに失敗しました。)

PK3Err0018: NMMR register read failed. (NMMR レジスタの読み出しに失敗しました。)

PK3Err0019: Failed while reading emulation registers. ( エミュレーション レジスタの読み
出しに失敗しました。)

PK3Err0020: Failed while writing emulation registers. ( エミュレーション レジスタの書き込
みに失敗しました。)

9.3.2「デバッガとターゲットの通信エラーの対処方法」を参照してください。

PK3Err0021: Command not echoed properly. Sent %x, received %x. ( コマンドのエコーが
正しくありません。送信 %x、受信 %x)

PK3Err0022: Failed to get PICkit 3 version information. (PICkit 3 のバージョン情報の取得に
失敗しました。)

PK3Err0024: Download RS failed. (RS のダウンロードに失敗しました。)

PK3Err0025: Download AP failed. (AP のダウンロードに失敗しました。)

9.3.3「デバッガと PC の通信エラーの対処方法」を参照してください。

PK3Err0026: Download program exec failed. (EXEC プログラムのダウンロードに失敗しました。)

[Debugger] メニューから書き込みを実行しようとしてこのエラーが表示された場合、
以下の解決方法を試してください。

1. PICkit 3 をデバッガとしての指定から解除する。

2. プロジェクトを閉じて MPLAB IDE を終了する。

3. MPLAB IDE を再起動してもう一度プロジェクトを開く。

4. もう一度 PICkit 3 をデバッガとして指定し、ターゲット デバイスへの書き込みを実行
する。

それでも解決しない場合、9.3.4「インストール ファイルが破損している場合の対処方法」
を参照してください。

PK3Err0027: Bulk transfer failed due to invalid checksum. ( チェックサム エラーによりバ
ルク転送に失敗しました。)

9.3.3「デバッガと PC の通信エラーの対処方法」を参照してください。

また、使っているケーブルの長さが適切である事を確認してください。
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PK3Err0028: Download device database failed. ( デバイス データベースのダウンロードに失
敗しました。)

このエラーが表示された場合、以下の解決方法を試してください。

1. もう一度ダウンロードする。( 一過性のエラーの場合があるため。)

2. 手動でダウンロードする。[Debugger]>[Settings] の順に選択して、[Configuration] タ
ブを選択し、[Manual Download] をクリックする。最も数の大きい .jamファイルを
選択して [Open] をクリックする。

PK3Err0029: Communication failure. Unexpected command echo response %x received 
from ICD 3. ( 通信エラー。PICkit 3 から予期しないコマンドエコー %x が返されました。)

9.3.3「デバッガと PC の通信エラーの対処方法」を参照してください。

PK3Err0030: Unable to read/find firmware File %s. ( ファームウェア ファイル %s が読み出
せないか、見つかりません。)

Hex ファイルが存在する場合、以下の解決方法を試してください。

• 再接続してもう一度試してみる。

• それでも解決しない場合、ファイルが破損している場合があります。MPLAB IDE を再
インストールする。

Hex ファイルが存在しない場合、以下の解決方法を試してください。

• MPLAB IDE を再インストールする。

PK3Err0031: Failed to get PC. (PC の取得に失敗しました。)

PK3Err0032: Failed to set PC. (PC の設定に失敗しました。)

9.3.2「デバッガとターゲットの通信エラーの対処方法」を参照してください。

PK3Err0033: %d bytes expected, %d bytes received. 
(%d バイト中、%d バイト受信しました。)

9.3.3「デバッガと PC の通信エラーの対処方法」を参照してください。

PK3Err0034: This version of MPLAB IDE does not support hardware revision %06x. 
Please upgrade to the latest version of MPLAB IDE before continuing. 
( このバージョンの MPLAB IDE はハードウェア リビジョン %06x をサポートしていません。
最新バージョンの MPLAB IDE にアップグレードしてから作業を続けてください。)

最新の MPLAB IDE を www.microchip.com から入手してください。

PK3Err0035: Failed to get Device ID. ( デバイス ID の取得に失敗しました。)

9.3.1「読み書きエラーの対処方法」を参照してください。

PK3Err0036: MPLAB IDE has lost communication with PICkit 3. (MPLAB IDE と PICkit 3 の
通信が切断されました。)

9.3.3「デバッガと PC の通信エラーの対処方法」を参照してください。

PK3Err0037: Timed out waiting for response from PICkit 3. (PICkit 3 からの応答待機中にタ
イムアウトになりました。)

PK3Err0038: Failed to initialize PICkit 3. (PICkit 3 の初期化に失敗しました。)

PK3Err0039: PICkit 3 self-test failed. (PICkit 3 のセルフテストに失敗しました。)

このエラーは、デバッガが応答していない場合に表示されます。

1. デバッガと PC の接続ケーブルを一旦抜いて挿し直す。

2. MPLAB IDE でデバッガに再接続する。

3. それでも解決しない場合はマイクロチップ社までお問い合わせください。

PK3Err0040: The target device is not ready for debugging. Please check your 
Configuration bit settings and program the device before proceeding. 
( ターゲット デバイス側でデバッグの準備ができていません。コンフィグレーション ビットの
設定を確認してデバイスをもう一度プログラムしてから作業を続けてください。)

このメッセージが表示されるのは、デバイスをプログラムせずに実行しようとした場合
です。＝このような場合、またはデバイスのプログラミング直後にこのメッセージが表
示された場合、9.3.6「デバッグエラーの対処方法」を参照してください。
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PK3Err0043: RS download failed. (RS のダウンロードに失敗しました。)

PK3Err0044: AP download failed. (AP のダウンロードに失敗しました。)

PK3Err0045: You must connect to a target device to use PICkit 3. 
(PICkit 3 を使用するには、ターゲット デバイスに接続する必要があります。)

電源が未検出です。

1. デバッガとターゲットの間で VDD と GND が接続されている事を確認する。

2. ターゲットに電源が供給されている事を確認する。

3. デバッガが検出できる十分な電力がターゲットに供給されている事を確認する
( 補遺 A.「ハードウェア仕様」参照 )。

PK3Err0046: An error occurred while trying to read the stopwatch count. The stopwatch 
count may not be accurate. 
( ストップウォッチのカウント読み出し中にエラーが発生しました。ストップウォッチのカウ
ント値が正確でない可能性があります。)

9.3.2「デバッガとターゲットの通信エラーの対処方法」を参照してください。

PK3Err0047: Bootloader download failed. ( ブートローダのダウンロードに失敗しました。)

9.3.3「デバッガと PC の通信エラーの対処方法」を参照してください。

PK3Err0052: The current PICkit 3 hardware version %x, is out of date. This version of 
MPLAB IDE will support only version %x or higher. 
( 現在の PICkit 3 のハードウェア バージョン %x は旧バージョンです。お使いの MPLAB IDE
はバージョン %x 以上のみサポートします。)

最新ファームウェアのダウンロードを確認するダイアログで [Cancel] をクリックしませ
んでしたか。もしそうなら、最新ファームウェアをすぐにダウンロードしてください。
[Debugger]>[Settings] の順に選択して、[Configuration] タブを選択し、[Manual 
Download] をクリックします。最も大きい数字の .jamファイルを選択して [Open] を
クリックします。

ダウンロードするファイルが見つからない場合や、上記手順でも解決しない場合 ( ファ
イルが破損している可能性があります ) は、最新バージョンの MPLAB IDE を入手して
インストールしてください。最新の MPLAB IDE を www.microchip.com から入手して
ください。

PK3Err0053: Unable to get PICkit 3 protocol versions. (PICkit 3 のプロトコル バージョンの
取得に失敗しました。)

9.3.3「デバッガと PC の通信エラーの対処方法」を参照してください。

PK3Err0054: MPLAB IDE's PICkit 3 protocol definitions are out of date. You must upgrade 
MPLAB IDE to continue. (MPLAB IDE の PICkit 3 プロトコル定義は旧バージョンです。
MPLAB IDE をアップグレードしてから作業を続けてください。)

最新の MPLAB IDE を www.microchip.com から入手してください。

PK3Err0055: Unable to set firmware suite version. ( ファームウェア スイートのバージョン
を設定できません。)

PK3Err0056: Unable to get voltages from PICkit 3. (PICkit 3 から電圧を取得できません。)

9.3.3「デバッガと PC の通信エラーの対処方法」を参照してください。

PK3Err0068: Failed while writing to boot Flash memory. ( ブート フラッシュメモリへの書き
込みに失敗しました。)

PK3Err0069: Failed while reading boot Flash memory. ( ブート フラッシュメモリの読み出
しに失敗しました。)

PK3Err0070: Failed while writing peripheral memory. ( 周辺メモリへの書き込みに失敗しま
した。)

PK3Err0071: Failed while reading peripheral memory. ( 周辺メモリの読み出しに失敗しました。)

9.3.1「読み書きエラーの対処方法」を参照してください。

PK3Err0072: Unable to send freeze peripheral information. ( 周辺モジュールのフリーズ情
報を送信できません。)
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PK3Err0073: Device is code-protected. ( デバイスがコード保護されています。)

操作 ( 読み出し、書き込み、ブランクチェック、ベリファイ ) を行おうとしたデバイス
のコード保護が有効になっており、コードの読み出しまたは変更が行えません。コード
保護に関するコンフィグレーション ビットの設定を確認してください。

コード保護を無効にするには、デバイスのデータシートを参照して該当するコンフィグ
レーション ビットをコード内または [Configuration Bits] ウィンドウ
([Configure]>[Configuration Bits]) でセットまたはクリアします。その後で、デバイス全
体を消去してから再プログラムします。

PK3Err0075: Unable to set power. ( 電源をセットできません。)

PICkit 3 からターゲットに電源を供給できません。

PK3Err0080: Failed setting shadow bit(s). ( シャドウビットの設定に失敗しました。)

9.3 一般的な対処方法

以下、問題が発生した場合の一般的な対処方法を紹介します。

• 読み書きエラーの対処方法

• デバッガとターゲットの通信エラーの対処方法

• デバッガと PC の通信エラーの対処方法

• インストール ファイルが破損している場合の対処方法

• USB ポート通信エラーの対処方法

• デバッグエラーの対処方法

• 内部エラーの対処方法

9.3.1 読み書きエラーの対処方法

読み書きエラーが発生した場合、以下の事項を確認してください。

1. [Abort] をクリックしたかどうか ( この操作で読み書きエラーが発生する事があるため )。

2. 同じ操作を繰り返してみる ( 一過性のエラーの場合があるため )。

3. ターゲットに電源が供給されており、デバイスの電圧レベルが適正である事を確認する
( デバイスの適正電圧は、各デバイスのデータシートを参照してください。)

4. デバッガとターゲットの接続が正しい事 (PGC と PGD が接続されている事 ) を確認する。

5. 書き込みエラーの場合、[Settings]ダイアログの [Program Memory]タブで [Erase all before
Program] にチェックが入っている事を確認する。

6. 使っているケーブルの長さが適切である事を確認する。

9.3.2 デバッガとターゲットの通信エラーの対処方法

PICkit 3 プログラマ / デバッガとターゲット デバイスの同期がとれていません。

1. [Reset] を選択してから同じ操作を再試行する。

2. 使っているケーブルの長さが適切である事を確認する。

9.3.3 デバッガと PC の通信エラーの対処方法

PICkit 3 プログラマ / デバッガと MPLAB IDE の同期がとれていません。

1. デバッガと PC の接続ケーブルを一旦抜いて挿し直す。

2. デバッガに再接続する。

3. 同じ操作を繰り返してみる ( 一過性のエラーの場合があるため )。

4. インストールされている MPLAB IDE のバージョンが、PICkit 3 プログラマ / デバッガに読
み込まれているファームウェアのバージョンに対応していない可能性がある。9.3.4「イン
ストール ファイルが破損している場合の対処方法」の手順に従う。
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9.3.4 インストール ファイルが破損している場合の対処方法

この問題は、ほとんどの場合、MPLAB IDE のインストールが不完全であるか、イン
ストールしたファイルが破損した事が原因で発生します。

1. 全てのバージョンの MPLAB IDE を PC からアンインストールする。

2. 使用するバージョンの MPLAB IDE を再インストールする。

3. それでも解決しない場合はマイクロチップ社までお問い合わせください。

9.3.5 USB ポート通信エラーの対処方法

この問題は、ほとんどの場合、通信ポートに問題があるか、存在しない通信ポート
を指定している事が原因で発生します。

1. PICkit 3 プログラマ / デバッガに再接続する。

2. デバッガが物理的に PC の適切な USB ポートに接続されている事を確認する。

3. デバッガの [Settings] で適切な USB ポートが選択されている事を確認する。

4. 指定した USB ポートを他のデバイスが使っていない事を確認する。

5. USB ハブを使う場合、電源が供給されている事を確認する。

6. USB ドライバが読み込まれている事を確認する。

9.3.6 デバッグエラーの対処方法

PICkit 3 プログラマ / デバッガでデバッグを実行できない場合、これには多くの原因
が考えられます。7.3「デバッグに失敗する主な理由」と 7.4「その他の確認事項」を
参照してください。

9.3.7 内部エラーの対処方法

内部エラーは予測できず、通常は発生すべきものではありません。これらは主にマイ
クロチップ社内の開発で使用します。

主な原因として、インストール ファイルの破損が考えられます (9.3.4「インストール 
ファイルが破損している場合の対処方法」参照 )。

また、システム リソースの減少が原因の事もあります。

1. システムを再起動してメモリを解放する。

2. ハードディスク ドライブに十分な空き容量がある事、過度なフラグメンテーションが発生
していない事を確認する。

それでも解決しない場合はマイクロチップ社までお問い合わせください。
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Chapter 10.  デバッガ機能一覧
10.1 はじめに

ここでは、MPLAB IDE のメニュー、ウィンドウ、ダイアログで表示される PICkit 3
プログラマ / デバッガの機能をまとめます。

• デバッグに関する機能

• デバッグに関するダイアログ / ウィンドウ

• プログラミングに関する機能

• [Settings] ダイアログ

10.2 デバッグに関する機能

[Debugger] メニューで PICkit 3 を選択すると、MPLAB IDE の機能に以下の項目が追
加されます。

• [Debugger] メニュー ― ドロップダウン メニューに項目が追加されます。

• デバッガに関する右クリック メニュー ― コンテクスト メニューに項目が追加されます。

• ツールバー / ステータス バー ― メニューバーの下にツールバーが表示されます。ステータ
スバーにも追加の情報が表示されます。

10.2.1 [Debugger] メニュー

[Run] (F9 キー )

ブレークポイントまで、または [Halt] を選択するまでプログラムコードを実行します。

コード実行は、現在のプログラム カウンタ ( ステータスバーに表示 ) から開始します。
現在のプログラム カウンタ位置は、[Program Memory] ウィンドウのポインタでも確認
できます。プログラム実行中は、一部の機能が無効になります。

[Animate]

[Animate] を実行すると、デバッガが 1 ステップずつ実行し、画面に表示されるレジ
スタの値もそれに合わせて更新されます。

Animate は Run よりも実行速度が遅い一方で、[Special Function Register] ウィンドウ
または [Watch] ウィンドウでレジスタの値の変化を確認できます。

Animate を停止するには、メニューで [Debugger]>[Halt] の順にクリックするか、
ツールバーの [Halt] をクリックするか、<F5> キーを押します。

[Halt] (F5 キー )

[Halt] を実行すると、プログラムコードの実行が停止します。[Halt] をクリックする
と、ステータス情報が更新されます。

[Step Into] (F7 キー )

プログラムコードを 1 ステップずつ実行します。

アセンブリコードの場合、1 命令 (1 サイクル命令または複数サイクル命令 ) を実行
して停止します。1 命令を実行するたびに、全てのウィンドウが更新されます。
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C コードの場合、コードを 1 行 ( アセンブリ命令レベルでは複数の命令に相当する事
もあります ) ずつ実行して停止します。実行が完了するたびに、全てのウィンドウが
更新されます。

[Step Over] (F8 キー )

現在のプログラム カウンタ位置の命令を実行します。CALL命令があると、呼び出さ
れたサブルーチンを実行後、CALL命令の次のアドレスで停止します。Step Over が
長時間終了しない場合、またはハングしたと思われる場合、[Halt] をクリックします。

[Step Out]

利用できません。

[Reset]>[Processor Reset] (F6 キー )

ターゲット プロセッサにリセット シーケンスを送信します。MCLR が発行され、プロ
グラム カウンタはリセットベクタに戻ります。

[Breakpoints]

[Breakpoints] ダイアログを開きます (10.3.1「[Breakpoints] ダイアログ」参照 )。
ハードウェア ブレークポイントを使うと、コードの指定行でコード実行を停止でき
ます。このダイアログで複数のブレークポイントを設定します。

[Program]

コードをターゲット デバイスにダウンロードします。

[Read]

ターゲットのメモリを読み出します。情報は MPLAB IDE にアップロードされます。

[Erase Flash Device]

フラッシュメモリ全体を消去します。

[Abort Operation]

プログラミング操作 ( プログラム、読み出し等 ) を中止します。操作を中止すると、
デバイスの状態は未知となります。

[Reconnect]

PC と PICkit 3 プログラマ / デバッガの通信再開を試みます。接続の進行状況は、
[Output] ダイアログの [PICkit 3] タブに表示されます。

[Settings]

PICkit 3 の [Settings] ダイアログを開きます (10.5「[Settings] ダイアログ」参照 )。
プログラムとファームウェアのオプションを設定します。

Note: [Step Into] では SLEEP命令を実行しないでください。

Note: コード行を右クリックまたはダブルクリックすると、その行に単純ブレー
クポイントを設定できます。
DS51795B_JP - p.58  2012 Microchip Technology Inc.



デバッガ機能一覧
10.2.2 デバッガに関する右クリック メニュー

プログラムメモリやソースコード ファイル等のコード表示画面を右クリックすると、
デバッガに関する以下のメニューオプションが表示されます。ここに記載されてい
ないメニューオプションは、MPLAB IDE ヘルプまたは MPLAB エディタのヘルプを
参照してください。

[Set Breakpoint]

現在選択している行にブレークポイントを設定 ( または解除 ) します。

[Breakpoints]

全てのブレークポイントを一括して削除、有効化、無効化します。

[Run To Cursor]

現在のカーソル位置までプログラムを実行します。以前の [Run to Here] と同じです。

[Set PC at Cursor]

現在のカーソル位置にプログラム カウンタ (PC) をセットします。

[Center Debug Location]

現在 PC がセットされている行をウィンドウの中央に表示します。

10.2.3 ツールバー / ステータス バー

PICkit 3 プログラマ / デバッガをデバッガとして指定すると、MPLAB IDE に以下の
ツールバーが表示されます。

• 基本的なデバッグ ツールバー ([Run]、[Halt]、[Animate]、[Step Into]、[Step Over]、[Step Out]、
[Reset]、[Breakpoints])

• シンプルなプログラム ツールバー ([Program]、[Read]、[Erase Flash Device])

MPLAB IDE デスクトップの一番下にあるステータスバーには、現在選択されている
デバッガ (PICkit 3) とその他の開発に関する情報が表示されます。ステータスバーの
詳細は、MPLAB IDE のオンラインヘルプを参照してください。

10.3 デバッグに関するダイアログ / ウィンドウ

10.2「デバッグに関する機能」に記載したメニュー項目をクリックすると、デバッグ
に関する以下のダイアログまたはウィンドウが開きます。

• [Breakpoints] ダイアログ

- [Set Breakpoint] ダイアログ

- [Stopwatch] ダイアログ

- [Event Breakpoints] ダイアログ

10.3.1 [Breakpoints] ダイアログ

ブレークポイントを設定するには、[Debugger]>[Breakpoints] の順にクリックします。

このダイアログでは、各種ブレークポイントを設定できます。[Add Breakpoint] を
クリックすると、ブレークポイントの一覧に新規ブレークポイントを追加できます。
選択したデバイスによっては、より高度なブレークポイント機能に関するボタンが
表示される事があります。
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10.3.1.1 [BREAKPOINTS] ダイアログ ウィンドウ

このウィンドウには、各ブレークポイントに関する情報が表示されます。

このウィンドウにブレークポイントを追加した後、ブレークポイントを右クリック
すると、以下のメニューオプションが表示されます。

• [Delete] ― 選択したブレークポイントを削除します。

• [Edit/View] ― [Set Breakpoint] ダイアログを開きます。

• [Delete All] ― 一覧に表示されたブレークポイントを全て削除します。

• [Disable All] ― 一覧に表示されたブレークポイントを全て無効にします。

10.3.1.2 [BREAKPOINTS] ダイアログのボタン

これらのボタンを使ってブレークポイントを追加したり、ブレーク条件を詳しく設
定したりできます。また、ブレークポイントとトリガにストップウォッチを組み合
わせて使う事もできます。

表 10-1: [BREAKPOINTS] ダイアログ ウィンドウ

コントロール 機能

[Breakpoint Type] ブレークポイントの種類 ( プログラムまたはデータ )

[Address] ブレークポイント位置のアドレス (16 進数 )

[File Line #/Symbol Name] ファイル名とブレークポイント位置の行番号

[Enabled] チェックしてブレークポイントを有効化

Note: 表示されるボタンは、選択したデバイスによって決まります。

表 10-2: [BREAKPOINTS] ダイアログのボタン

コントロール 機能 関連するダイアログ

[Add Breakpoint] ブレークポイントの追加 10.3.2「[Set Breakpoint] ダイアログ」

[Stopwatch] ストップウォッチの設定 10.3.3「[Stopwatch] ダイアログ」

[Event Breakpoints] イベント ブレークポイント
の設定

10.3.4「[Event Breakpoints] ダイアログ」
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10.3.2 [Set Breakpoint] ダイアログ

[Breakpoints] ダイアログで [Add Breakpoint] をクリックすると、このダイアログが
表示されます。

[Breakpoints] ダイアログに追加するブレークポイントをここで設定します。

10.3.2.1 [PROGRAM MEMORY] タブ

プログラムメモリのブレークポイントをここで設定します。

10.3.2.2 [DATA MEMORY] タブ

データメモリのブレークポイントをここで設定します。

表 10-3: プログラムメモリのブレークポイント

コントロール 機能

[Address] ブレークポイントのアドレス (16 進数 )

[Breakpoint Type] プログラムメモリ ブレークポイントの種類です。テーブル読み書き
の詳細は、各デバイスのデータシートを参照してください。
[Program Memory Execution]: 上記アドレスの実行でブレークします。
[TBLRD Program Memory]: 上記アドレスに対するテーブル読み出し
でブレークします。
[TBLWT Program Memory]: 上記アドレスに対するテーブル書き込み
でブレークします。

[Pass Count] ブレーク条件にパスカウントを設定します。
[Always break]: [Breakpoint type] で指定したイベントで常にブレーク
します。
[Break occurs Count instructions after Event]: [Breakpoint type] で指
定したイベントの後、[Count] で指定した数 (0 ～ 255) の命令を実行
してからブレークします。
[Event must occur Count times]: [Breakpoint type] で指定したイベン
トが [Count] で指定した回数 (0 ～ 255) 発生するとブレークします。

表 10-4: データメモリのブレークポイント

コントロール 機能

[Address] ブレークポイントのアドレス (16 進数 )

[Breakpoint Type] データメモリ ブレークポイントの種類です。X バス読み書きの詳細
は、各デバイスのデータシートを参照してください。
[X Bus Read]: 上記アドレスに対する X バス読み出しでブレークします。
[X Bus Read Specific Byte]: 上記アドレスの X バス読み出しの値が
[Specific Value] で指定したバイト値ならブレークします。
[X Bus Read Specific Word]: 上記アドレスの X バス読み出しの値が
[Specific Value] で指定したワード値ならブレークします。
[X Bus Write]: 上記アドレスに対する X バス書き込みでブレークします。
[X Bus Write Specific Byte]: 上記アドレスの X バス書き込みの値が
[Specific Value] で指定したバイト値ならブレークします。
[X Bus Write Specific Word]: 上記アドレスの X バス書き込みの値が
[Specific Value] で指定したワード値ならブレークします。

[Pass Count] ブレーク条件にパスカウントを設定します。
[Always break]: [Breakpoint type] で指定したイベントで常にブレーク
します。
[Break occurs Count instructions after Event]: [Breakpoint type] で指定
したイベントの後、[Count] で指定した数 (0 ～ 255) の命令を実行し
てからブレークします。
[Event must occur Count times]: [Breakpoint type] で指定したイベン
トが [Count] で指定した回数 (0 ～ 255) 発生するとブレークします。
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10.3.3 [Stopwatch] ダイアログ

[Breakpoints] ダイアログで [Stopwatch] をクリックすると、ストップウォッチ設定
ダイアログが表示されます。

ブレークポイントとストップウォッチを併用すると、コード実行の時間を計測でき
ます。ストップウォッチを使うと、2 つのブレークポイント / トリガ条件の間の経過
時間を計測できます。ストップウォッチの値は 10 進数です。

コードにブレークポイントを設定するには、以下のいずれかの操作を行います。

• コードの任意の行をダブルクリックまたは右クリックして、個別にブレークポイントを設定する。

• [Debugger]>[Breakpoints] の順にクリックして [Breakpoints] ダイアログを開き、複数のブ
レークポイントとその条件を設定する ( 詳細は 10.3.1「[Breakpoints] ダイアログ」参照 )。

2 つのブレークポイント間の時間を計測するには、以下の手順でストップウォッチを
使用します。

1. [Breakpoints] ダイアログを開く ([Debugger]>[Breakpoints])。

2. [Breakpoints] ダイアログで [Stopwatch] をクリックして [Stopwatch] ダイアログを開く。

3. [Start Condition] のドロップダウン リストから、開始条件のブレークポイントを選択する。
必要に応じて [Start condition will cause the target device to halt] にチェックを入れる。

4. [Stop Condition] のドロップダウン リストから、終了条件のブレークポイントを選択する。
必要に応じて [Stop condition will cause the target device to halt] にチェックを入れる。

5. 必要に応じて [Reset stopwatch on run] にチェックを入れる。

6. [OK] をクリックする。

10.3.4 [Event Breakpoints] ダイアログ

[Breakpoints] ダイアログで [Event Breakpoints] をクリックすると、このダイアロ
グが表示されます。

プログラム実行を必ず停止する条件をここで選択します。

• [Break on Watchdog Timer] ― ウォッチドッグ タイマのタイムアウトで必ず停止します。
コンフィグレーション ビットでウォッチドッグ タイマが有効に設定されている事を確認し
てください。

• [Break on SLEEP instruction] ― プログラム内で SLEEP命令が出現したら実行を停止します。

10.4 プログラミングに関する機能

[Programmer] メニューで PICkit 3 プログラマ / デバッガを選択すると、以下の
MPLAB IDE 機能にプログラムに関する項目が追加されます。

• [Programmer] メニュー

表 10-5: ストップウォッチの設定

コントロール 機能

[Start Condition] ストップウォッチの開始条件となるブレークポイントまたはトリ
ガを選択します。あらかじめ [Breakpoints] ダイアログに追加済み
のブレークポイント / トリガの中から選択できます。
開始条件をクリアするには、[None] を選択します。
[Start condition will cause the target device to halt] にチェックを入
れると、この条件でプログラム実行が停止します。

[Stop Condition] ストップウォッチの終了条件となるブレークポイントまたはトリ
ガを選択します。先に [Breakpoints] ダイアログに追加したブレー
クポイント / トリガの中から選択できます。
終了条件をクリアするには、[None] を選択します。
[Stop condition will cause the target device to halt] にチェックを入
れると、この条件でプログラム実行が停止します。

[Reset stopwatch on run] プログラムを実行するたびにストップウォッチの値を 0 にリセッ
トします。
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• ツールバー / ステータスバー

10.4.1 [Programmer] メニュー

[Program]

指定したメモリ領域 ( プログラムメモリ、コンフィグレーション ビット、ID ロケー
ション、EEPROM データ ) にプログラミングを実行します。プログラミングのオプ
ションは [Settings] ダイアログを参照してください。

[Verify]

指定したメモリ領域 ( プログラムメモリ、コンフィグレーション ビット、ID ロケー
ション、EEPROM データ ) に書き込んだ内容を検証します。

[Read]

指定したメモリ領域 ( プログラムメモリ、コンフィグレーション ビット、ID ロケー
ション、EEPROM データ ) から読み出しを実行します。読み出しのオプションは
[Settings] ダイアログを参照してください。

[Blank Check All]

デバイスのメモリが全て消去されてブランクである事を確認します。

[Erase Flash Device]

フラッシュメモリ全体を消去します。

[Abort Operation]

プログラミング操作 ( プログラム、読み出し等 ) を中止します。操作を中止すると、
デバイスの状態は未知となります。

[Reconnect]

PC と PICkit 3 プログラマ / デバッガの通信再開を試みます。接続の進行状況は、
[Output] ダイアログの [PICkit 3] タブに表示されます。

[Settings]

[Programmer] ダイアログを開きます (10.5「[Settings] ダイアログ」参照 )。プログ
ラムとファームウェアのオプションを設定します。

10.4.2 ツールバー / ステータスバー

PICkit 3 プログラマ / デバッガをプログラマとして指定すると、MPLAB IDE に以下
のツールバーが表示されます。

• 基本的なプログラム ツールバー ([Program]、[Read]、[Verify]、[Erase Flash Device]、[Blank Check 
All])。

MPLAB IDE デスクトップの一番下にあるステータスバーには、現在選択されているプロ
グラマ (PICkit 3) とその他プログラミングに関する情報が表示されます。ステータスバー
の表示内容は、MPLAB IDE のオンラインヘルプを参照してください。

10.5 [SETTINGS] ダイアログ

[Debugger]>[Settings] または [Programmer]>[Settings] の順にクリックすると
[Settings] ダイアログが開き、PICkit 3 プログラマ / デバッガを設定できます。

• [Settings] ダイアログの [Program Memory] タブ

• [Settings] ダイアログの [Configuration] タブ

• [Settings] ダイアログの [Freeze on Halt] タブ

Note: 表示されるタブの内容は、選択したデバイスと、PICkit 3 をデバッガと
プログラマのいずれとして選択したかによって決まります。
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• [Settings] ダイアログの [Status] タブ

• [Settings] ダイアログの [Clock] タブ

• [Settings] ダイアログの [Secure Segment] タブ

• [Settings] ダイアログの [Warning] タブ

• [Settings] ダイアログの [Power] タブ

• [Settings] ダイアログの [Limitations] タブ

• [Settings] ダイアログの [Programmer-to-go] タブ

10.5.1 [Settings] ダイアログの [Program Memory] タブ

このタブを使うと、デバッグ / プログラミングのオプションを設定できます。

表 10-6: [PROGRAM MEMORY] タブのオプション
[Allow PICkit 3 to 
select memories and 
ranges]

こちらを選択すると、選択済みのデバイスと既定値の設定に基づい
て、PICkit 3 がプログラムするメモリとアドレス範囲を決めます。

[Manually select 
memories and ranges]

こちらを選択すると、選択済みのデバイスのメモリ、プログラムメモ
リ範囲、プログラム オプションをユーザが決める必要があります。

[Memories:]

[Program] チェックを入れると、プログラムメモリをターゲットに書き込みます。

[Configuration] チェックを入れると、コンフィグレーション ビットをターゲットに
書き込みます。
Note: このメモリは、PICkit 3 をデバッガとして選択すると常に書
き込まれます。

[EEPROM] チェックを入れると、ターゲットが EEPROM メモリを実装してい
る場合、消去してから書き込みを実行します。チェックを外すと、
ターゲットの EEPROM メモリを消去します。

[ID] チェックを入れると、ID メモリをターゲットに書き込みます。

[Boot Flash] サポートされている場合、チェックを入れるとターゲットのブート
メモリに書き込みます。

[Program Memory Range:]

[Start]、[End] 書き込み、読み出し、ベリファイを行うプログラムメモリのアドレ
ス範囲を開始アドレスと終了アドレス ( いずれも 16 進数 ) で指定し
ます。
終了アドレスが正しくないためプログラミング エラーが発生した場
合、再接続後に終了アドレスを訂正して書き込みを再度実行する必
要があります。
Note: ここで指定したアドレス範囲は消去機能には適用されません。
消去機能はデバイスの全データを対象に実行されます。

[Program Options:]

[Erase all before 
Program]

チェックを入れると、書き込みを開始する前にメモリ全体を消去し
ます。
新しいデバイスまたは消去済みデバイスに書き込む場合を除き、こ
のボックスには必ずチェックを入れてください。チェックを入れな
い場合はデバイスが消去されず、デバイスに既存のコードと新しい
プログラムコードがマージされます。

[Preserve Program 
Memory Range]

チェックを入れると、メモリ範囲が保持されます。
[Start]、[End] – 保持するプログラムメモリの範囲を開始アドレスと
終了アドレス ( いずれも 16 進数 ) で指定します。
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10.5.2 [Settings] ダイアログの [Configuration] タブ

このタブでは、デバッガの動作を設定します。

10.5.3 [Settings] ダイアログの [Freeze on Halt] タブ

このタブでは、Halt 時にフリーズする周辺モジュールを選択します。

PIC12/16 MCU

デバイスの全ての周辺モジュールに対して停止時のフリーズの有効 / 無効を設定する
には、[Freeze on Halt] チェックボックスの ON/OFF を切り換えます。チェックを入
れても特定の周辺モジュールが停止しない場合、一部の周辺モジュールは Freeze on 
Halt 機能をサポートしておらず、エミュレータでは制御できないため注意してくだ
さい。

デバイスによっては、Freeze on Halt をサポートする周辺モジュールに制約がある場合
があります。制約に関する詳細は、[Limitations] ボタンをクリックして確認します。

PIC18 MCU

デバイスの全ての周辺モジュールに対して停止時のフリーズの有効 / 無効を設定する
には、[Freeze on Halt] チェックボックスの ON/OFF を切り換えます。チェックを入
れても特定の周辺モジュールが停止しない場合、一部の周辺モジュールは Freeze on 
Halt 機能をサポートしておらず、デバッガでは制御できないため注意してください。

[Use high voltage on 
MCLR]

PIC24FXXKAXXX の場合 :
ピンを通常の入力ピンまたは MCLR リセットに設定する際に高電圧
を使う場合、チェックを入れます。
低電圧の MCLR リセットの場合、チェックを外します。

Notes:

1. コンフィグレーション設定が「MCLR ピン = 有効、RA5 入力ピン
= 無効」の場合、低電圧エントリを使用できます ([Use high voltage
on MCLR] オプションのチェックを外す )。

2. コンフィグレーション設定が「RA5 入力ピン = 有効、MCLR = 無
効」の場合、[Use high voltage on MCLR] オプションにチェック
を入れる必要があります。

3. コンフィグレーション設定で「MCLR ピン イネーブルビット」を
プログラムする場合、[Use high voltage on MCLR] オプションに
チェックを入れる必要があります。

4. 「-ICE」ヘッダを使う場合、このチェックボックスの設定は無視
されます。

[Automatically]

[Program after 
successful build]

アプリケーション コードのビルドが正常に完了したら、このコード
をデバイスに書き込みます。

[Run after successful 
program]

このオプションはデバッグモードでのみ有効です。
アプリケーション コードをターゲット デバイスに正しく書き込ん
だ後、コードを実行します。

表 10-7: [CONFIGURATION] タブの項目
[Download Firmware] ファームウェア ダウンロードのオプションを設定します。

[Auto Download Latest 
Firmware]

チェックを入れると、ターゲット デバイスの最新バージョンの
ファームウェアを自動的にダウンロードできます ( 推奨 )。

[Manual Download] ターゲット デバイスにダウンロードするファームウェア ファイル
を手動で選択します。

表 10-6: [PROGRAM MEMORY] タブのオプション ( 続き )
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dsPIC30F/33F、PIC24F/H、PIC32MX

[Peripherals to Freeze on Halt] リストで、Halt 時にフリーズしたい周辺モジュールに
チェックを入れます。チェックを外した周辺モジュールは、プログラム実行が停止
しても動作を継続します。該当の周辺モジュールがリストにない場合、[All Other 
Peripherals] にチェックを入れます。チェックを入れても特定の周辺モジュールが停
止しない場合、一部の周辺モジュールは Freeze on Halt 機能をサポートしておらず、
デバッガでは制御できないため注意してください。

[All Other Peripherals] を含め、全ての周辺モジュールを選択するには、[Check All]
をクリックします。[All Other Peripherals] を含め、全ての周辺モジュールの選択を
解除するには、[Uncheck All] をクリックします。

10.5.4 [Settings] ダイアログの [Status] タブ

このタブでは、PICkit 3 システムのステータスを確認できます。

表 10-8: [STATUS] タブの項目
[Versions]

[Firmware Suite Version] デバッガのファームウェア スイートのバージョンです。ファーム
ウェア スイートは以下の 3 つの項目で構成されます。

[Algorithm Plug-in 
Version]

デバッガのアルゴリズム プラグインのバージョンです。選択したデ
バイスに、ターゲットに装着したデバイスをサポートするアルゴリズ
ムを使用します。

[OS Version] デバッガのオペレーティング システムのバージョンです。

[Voltages]

[PICkit™ 3 VPP] デバッガの VPP です。

[PICkit 3 VDD] デバッガの VDD です。

[Refresh Voltages] [Status] タブに表示される電圧値は、このタブがアクティブになった
時点のものです。表示内容を更新したい場合、このボタンをクリック
します。
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10.5.5 [Settings] ダイアログの [Clock] タブ

このタブでは、デバッグクロック モードを選択します。[FRC in Debug mode] に
チェックを入れると、デバッグ中は高速 RC クロックを使用します。

デバイスのエミュレーションはプロセッサの動作速度で行われます。プロセッサの動
作周波数が低い場合 (32 kHz 等 )、ステップ実行、[Watch] ウィンドウのリフレッシュ
等、全ての動作が遅くなります。しかし、プロセッサによっては高速 RC オシレータ
を内蔵しているものもあります。[FRC in Debug mode] オプションにチェックを入れ
ると、アプリケーション ( 通常の動作速度 ) の停止後に高速オシレータに切り換わり、
エミュレーションと周辺モジュール ( フリーズしていない場合 ) をより高速で実行で
きます。

10.5.6 [Settings] ダイアログの [Secure Segment] タブ

CodeGuard™ セキュリティ対応デバイスは、このタブでセキュア セグメントのプロ
パティを設定します。

CodeGuard セキュリティ機能の詳細は、マイクロチップ社ウェブサイトで公開され
ている 16 ビットデバイス向けリファレンス マニュアルの『Section 1. CodeGuard 
Security』(DS70180)、dsPIC33F/PIC24H および dsPIC30F のプログラミング仕様
を参照してください。

10.5.7 [Settings] ダイアログの [Warning] タブ

このタブには、PICkit 3 プログラマ / デバッガの全ての警告が一覧表示されます。

• 警告の項目にチェックを入れると、その警告が有効になります。警告は [Output] ウィンドウ
に表示されます。

• 警告の項目のチェックを外すと、その警告は無効になります。

エラーとは異なり、警告が発生してもプロジェクトのビルドは中止されません。
エラーメッセージが出力された場合、Chapter 9.「エラーメッセージ」を参照してく
ださい。

10.5.8 [Settings] ダイアログの [Power] タブ

このタブでは、電源オプションを設定します。

• チェックボックスをクリックして、[Power target circuit from PICkit 3] の有効 / 無効を切り
換えます。

この項目にチェックを入れると、ツールバーの [Power on/off] ボタンが有効になります。
このボタンは、初期状態では「電源 ON」の状態です。クリックするたびに ON と OFF
が切り換わります。ON の時にクリックすると OFF になり、OFF の時にクリックすると
ON になります。[Power target circuit from PICkit 3] のチェックを外すと、[Power on/off]
ボタンは無効な状態に戻ります。

ワークスペースを開くと、最後にそのワークスペースを保存した時の状態で開きます。

• スライドバーを調整して電圧を設定します。スライドバーを動かすと、フィールドの数値が
変化します。

10.5.9 [Settings] ダイアログの [Limitations] タブ

このタブには、選択したデバイスの全般的な制約が表示されます。[Details] をク
リックすると、制約の詳細が表示されます。

表 10-9: [SECURE SEGMENT] タブのオプション
[Full Chip Programming] クリックすると、プログラムメモリの全てのセグメントに対する

書き込みが選択されます。

[Segment Programming] クリックすると、セグメント プログラミングが選択されます。
以下のいずれかを選択します。
- [Boot, secure and general segments]
- [Secure and general segments]
- [General segment only]
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10.5.10 [Settings] ダイアログの [Programmer-to-go] タブ

このタブでは、プログラミング イメージに名前を付けて PICkit 3 のメモリに送信で
きます。

表 10-10: [PROGRAMMER-TO-GO] タブのオプション
[Image Name] プログラミング イメージの名前を入力します。

[Programmer Setting 
Report]

デバイスのプログラミングに関して選択した設定を表示し
ます。設定を変更する場合、[PICkit 3 Settings] ダイアログ
の適切なタブを使います。

[Send Image In Memory] MPLAB IDE から PICkit 3 へイメージ転送を実行します。
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補遺 A. ハードウェア仕様
A.1 はじめに

ここでは、PICkit 3 プログラマ / デバッガシステムのハードウェア仕様と電気的仕様
について詳しく説明します。

A.2 ハイライト

この章の内容は以下の通りです。

• 適合宣言書

• USB ポート / 電源

• PICkit 3 プログラマ / デバッガ

• 標準通信ハードウェア

• ターゲットボードに関する注意事項

A.3 適合宣言書

当社

Microchip Technology Inc.
2355 W. Chandler Blvd.
Chandler, Arizona 85224-6199
USA

は、以下の製品

PICkit 3 プログラマ / デバッガ

が、操作マニュアルに記載された制限事項を遵守した場合に以下の規格に適合する
事を宣言します。

規格 : EN61010-1 試験所用電気機器
Microchip Technology, Inc.
日付 :2009 年 1 月

PICkit 3 プログラマ / デバッガの使用に関する重要な注意事項

PICkit 3 プログラマ / デバッガは、その特殊な性質により、通常より高いレベルの電
磁放射を発生して無線機器等あらゆる種類の機器の動作に影響を与える事があるの
で注意してください。

従って、上記欧州規格に適合するためには、以下の制限事項を遵守する必要があり
ます。

1. 本開発システムの使用は工業地域 ( または同等地域 ) のみに限定する事。

2. 無線受信機やテレビ等、電磁波の影響を受ける可能性のある機器から 20 メートル以内の
場所で本システムを使用しない事。
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A.4 USB ポート / 電源

PICkit 3 プログラマ / デバッガは、mini USB 2.0 ポートを介してホスト PC に接続します。
USB コネクタはポッドの上部にあります。

本システムは USB インターフェイスを利用してファームウェアを再読み込みできます。

システムの電源は USB インターフェイスから供給されます。このデバッガは USB
仕様の「ハイパワー システム」に分類され、デバッガモードとプログラマモードの
いずれの場合も 100 mA をやや上回る電力を USB から供給する必要があります。

ケーブル長 ― PC とデバッガを接続するケーブルは、正常動作に適した長さのもの
をキットに同梱しています。

セルフパワードハブ ― USB ハブを使う場合、バスパワードではなくセルフパワード 
タイプを使います。PC キーボード内蔵の USB ポートでは、デバッガの動作に十分
な電力が得られません。

PC の休止 / 省電力モード ― USB 接続による PC とデバッガの通信を確保するため、
休止モード等 PC の省電力モードを無効にします。

A.5 PICKIT 3 プログラマ / デバッガ

デバッガの筐体はメインボードを格納しており、USB コネクタとシングル インライン 
コネクタが付いています。デバッガの筐体にはインジケータ ライト (LED) もあります。

A.5.1 メインボード

メインボードには、インターフェイス プロセッサ、USB 2.0 インターフェイス、SPI、
エミュレーション デバイスへのプログラミング用のシリアル EE、内蔵フラッシュ、
インジケータ LED が実装されています。

A.5.2 インジケータ ライト (LED)

インジケータ ライトの意味は以下の通りです。

Note: PICkit 3 プログラマ / デバッガの電源は USB 接続から供給します。
ターゲットボードの電源は原則として自己給電とします。ただし、ター
ゲットの消費電流が 30 mA 未満の場合に限り、PICkit 3 から電源を供給
する事もできます。

LED 色 説明

POWER 緑 電源を投入またはターゲットを接続すると点灯します。

ACTIVE 青 PICkit™ 3 と PC の接続が確立されている時、またはコマンド送受信
時に点灯します。

STATUS 緑 デバッガが正常に動作しており、スタンバイ状態の時に点灯します。

黄 動作中 ( ビジー ) の時に点灯します。

赤 デバッガにエラーが発生すると点灯します。
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A.6 標準通信ハードウェア

デバッガとターゲットの標準通信 (2.3「デバッガとターゲットの通信」の「標準
ICSP による通信」) には、RJ-11 コネクタ付きのアダプタを使用します。

ヘッダボード使用時に標準通信を行うには、デバイス専用のプロセッサパック
(-ICE/ICD デバイスを装着した 8 ピンコネクタのヘッダボードと標準アダプタボード
のセット ) が必要になる事があります。

利用可能なヘッダボードの詳細は、『Header Board Specification』(DS51292) を参照
してください。

A.6.1 標準通信

標準通信は、ターゲット プロセッサとのメイン インターフェイスとなるものです。
この中には、ターゲット デバイスへの接続とプログラミングに必要な高電圧 (VPP)、
VDD 検出ライン、クロックおよびデータ接続が含まれます。

VPP の高電圧ラインは、エミュレーション プロセッサの電圧要件に応じて 1.8 ～ 14 V
の電圧を生成できます。

VDD 検出ラインには、ターゲット プロセッサからの電流が流れます。

クロックとデータの接続インターフェイスには、以下の特長があります。

• 高インピーダンス モードのクロックおよびデータ信号 (PICkit 3 プログラマ / デバッガシス
テムに電源が供給されていない場合を含む )

• ターゲット システムの不良または不適切な接続による過電圧からクロックおよびデータ信
号を保護

• プロトタイプまたはターゲット システムの電気的短絡による過電流からクロックおよび
データ信号を保護

図 A-1: 6 ピン標準ピン配置 

Note: 旧式のヘッダボードは 8 ピンコネクタではなく 6 ピンの RJ-11 コネクタ
を使っているため、デバッガと直接接続できます。
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2 VDD_TGT Power on target

3 GND Ground
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6 PGM (LVP) Low Voltage Programming
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A.6.2 モジュラケーブルとコネクタ

標準通信では、デバッガとターゲット アプリケーションをモジュラ ケーブルで接続
します。以下に、このケーブルとコネクタの仕様を示します。

A.6.2.1 モジュラコネクタの仕様

• メーカー名、製品番号 ― AMP Incorporated、555165-1

• 販売代理店名、製品番号 ― Digi-Key、A9031ND

図 A-2 の表に、アプリケーション側のモジュラコネクタの各ピンとマイクロコント
ローラのピンの対応を示します。この構成では、ICD の機能を全て利用できます。

図 A-2: ターゲットボードのモジュラコネクタのピン配置

A.6.2.2 モジュラプラグの仕様

• メーカー名、製品番号 ― AMP Incorporated、5-554710-3

• 販売代理店名、製品番号 ― Digi-Key、A9117ND

Modular 
Connector Pin

Microcontroller 
Pin

6 PGM (LVP)

5 RB6

4 RB7

3 Ground

2 VDD Target

1 VPP 1
6

ターゲットボードのモジュラコネクタの
ピン配置を基板はんだ面から見た図

1 6

ターゲットボードのモジュラ
コネクタを前から見た図

Target Board
Transition Socket

Device-ICE

AC164110
Adapter

Header

Power

PICkit™ 3

Mini-USB

to PC 
cable
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A.6.2.3 モジュラケーブルの仕様

• メーカー名、製品番号 ― マイクロチップ テクノロジー社、07-00024

A.7 ターゲットボードに関する注意事項

ターゲットボードには、選択したデバイス (1.8 ～ 5.0 V) とアプリケーションの要件
に合わせて電源を供給してください。

デバッガとターゲットの通信の方法によっては、ターゲットボードの回路に関して
何点かの注意事項があります。詳しくは以下のセクションを参照してください。

• 2.4.2「ターゲットとの接続回路」

• 2.4.5「デバッガの正常動作を妨げる回路」
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NOTES:
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補遺 B. PICkit 3 の回路図
ここでは、PICkit 3 開発プログラマ / デバッガの回路図を示します。デモボードの回
路図は、各ボードのユーザガイドを参照してください。

図 B-1: PICkit™ 3 の回路図 (1/2 ページ )
 2012 Microchip Technology Inc. DS51795B_JP - p.75
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図 B-2: PICkit™ 3 の回路図 (2/2 ページ )
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用語集
16 進数 (Hexadecimal)

0 ～ 9 の数字と A ～ F ( または a ～ f) のアルファベットを使用する、16 を底とした
記数法。A ～ F で 10 進数の 10 ～ 15 を表現する。一番右の桁が 1 の位、次の桁が
16 の位、その次の桁が 162 = 256 の位を表す。

1 対 1 のプロジェクト / ワークスペース モデル (One-to-One Project-Workspace 
Model)

1 つのワークスペースで 1 つのプロジェクトを扱う。MPLAB IDE におけるアプリ
ケーション開発の最も一般的な構成。[Configure]>[Settings] の順に選択して
[Projects] タブで [Use one-to-one project-workspace model] にチェックを入れて指
定する。

2 進数 (Binary)

0 と 1 の数字を使用する、2 を底とした記数法。一番右の桁が 1 の位、次の桁が 2 の位、
その次の桁が 22 = 4 の位を表す。

8 進数 (Octal)

0～ 7の数字のみ使用する、8を底とした記数法。一番右の桁が 1の位、次の桁が 8の位、
その次の桁が 82 = 64の位を表す。

[Watch] ウィンドウ (Watch Window)

ウォッチ変数の一覧が表示され、ブレークポイントで毎回表示が更新されるウィンドウ。

AND 条件ブレークポイント (ANDed Breakpoints)

プログラム実行を停止するために設定する AND 条件 ( ブレークポイント 1 とブレーク
ポイント 2 が同時に発生した場合のみプログラム実行を停止する )。AND 条件で実行
が停止するのは、データ メモリのブレークポイントとプログラム メモリのブレークポ
イントが同時に発生した場合のみ。

ANSI

American National Standards Institute ( 米国規格協会 ) の略。米国における標準規格
の策定と承認を行う団体。

ASCII

American Standard Code for Information Interchange の略。7 桁の 2 進数で 1 つの文
字を表現する文字セット エンコード方式。大文字、小文字、数字、記号、制御文字
等が含まれる。

Clean

MPLAB IDE の [Project] メニューの項目。アクティブなプロジェクトのオブジェクト 
ファイル、Hex ファイル、デバッグ ファイル等、全ての中間ファイルが削除される。
これらのファイルは、プロジェクトのビルド時に他のファイルから再構築される。

COFF

Common Object File Format の略。このフォーマットのオブジェクト ファイルには、
マシンコードの他、デバッグ等に関する情報が含まれる。

CPU

「中央演算処理装置」を参照。
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C 言語 (C)

簡潔な表現、現代的な制御フローとデータ構造、豊富に用意された演算子等を特長
とする汎用プログラミング言語。

DSC

「デジタル シグナル コントローラ」を参照。

DSP

「デジタル シグナル プロセッサ」を参照。

dsPIC DSC (dsPIC DSCs)

dsPIC デジタル シグナル コントローラの略。マイクロチップ社の DSC ファミリの
総称。

DWARF

Debug With Arbitrary Record Format の略。ELF ファイルのデバッグ情報フォーマット。

EEPROM

Electrically Erasable Programmable Read Only Memory の略。電気的に消去可能なタ
イプの PROM。データの書き込みと消去はバイト単位で行われる。EEPROM の内容
は電源を OFF にしても保持される。

ELF

Executable and Linking Format の略。この形式のオブジェクト ファイルにはマシン
コードが含まれる。デバッグその他の情報は DWARF で指定する。ELF/DWARF の
方が COFF よりも最適化したコードのデバッグに適している。

EPROM

Erasable Programmable Read Only Memory の略。再書き込みが行えるタイプの ROM
で、消去は紫外線照射によって行うものが主流。

FNOP

Forced No Operation の略。Forced NOPサイクルは、2 サイクル命令の 2 サイクル目で
発生する。PIC マイクロコントローラのアーキテクチャはパイプライン構造となって
おり、現在の命令を実行中に物理アドレス空間の次の命令がプリフェッチされる。
しかし、現在の命令によってプログラム カウンタが変化した場合、プリフェッチした
命令は明示的に無視され、Forced NOPサイクルが発生する。

GPR

General Purpose Register ( 汎用レジスタ ) の略。デバイスのデータメモリ (RAM) の
うち、汎用目的に使える部分。

Halt

プログラム実行を停止する事。Halt を実行する事は、ブレークポイントで停止する
事と同じ。

Hex コード (Hex Code)

実行可能な命令を 16 進数形式のコードで保存したもの。Hex コードは Hex ファイル
に保存される。

Hex ファイル (Hex File)

デバイスに書き込み可能な 16 進数形式のアドレスと値 (Hex コード ) を記述した ASCII
ファイル。

ICD

In-Circuit Debugger ( インサーキット デバッガ ) の略。MPLAB ICD と PICkit (Debug 
Express を含む ) はマイクロチップ社の ICD。
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ICE

In-Circuit Emulator ( インサーキット エミュレータ ) の略。MPLAB ICE 2000 と
MPLAB ICE 4000 システムはマイクロチップ社の従来型 ICE。
MPLAB REAL ICE システムはマイクロチップ社の次世代 ICE。

ICSP™

In-Circuit Serial Programming ( インサーキット シリアル プログラミング ) の略。
マイクロチップ社製の組み込みデバイスをシリアル通信を利用して最小限のデバイ
ス ピンでプログラミングする方法。

IDE

Integrated Development Environment ( 統合開発環境 ) の略。マイクロチップ社の
MPLAB IDE 等。

IEEE

Institute of Electrical and Electronics Engineers の略。

IRQ

「割り込み要求」を参照。

ISO

「国際標準化機構 (International Organization for Standardization)」を参照。

ISR

「割り込みサービスルーチン」を参照。

LVDS

Low Voltage Differential Signaling の略。銅線を使って、低ノイズ、低消費電力、低振幅
でデータを高速伝送 (Gbps) する方法。

通常の I/O とはいくつかの点で異なる。

通常のデジタル I/O は 5 V を High (2 進数の「1」)、0 V を Low (2 進数の「0」) として
動作する。一方、差動伝送方式では 3 つ目の電圧値 (-5 V) を使用する。これにより、
符号化に使用できるレベルが 1 つ増え、最大データ転送レートが向上する。

データ転送レートが向上すると、信号線の数が少なくすみ、UW (Ultra Wide) および
UW-2/3 SCSI ハードディスクでは 68 芯しか使用しない。これらのデバイスでは、短
距離で高いデータ転送レートが要求される。標準の I/O 転送方式では、SCSI ハード
ディスク ドライブの接続に 68 芯よりもはるかに多くの信号線が必要になる。

使用する電圧も標準の 5 V より低く、3.3 V または 1.5 V を使用する。

LVDS では、2 本の信号線を使って逆位相の信号を送信する。この方式ではノイズが
2 つの信号線とも同じレベルで伝送されるため、ノイズを簡単かつ効果的にフィルタ
リングできる。

標準の I/O シグナリングでは、データストレージは実際の電圧レベルに依存する。
電圧レベルは信号線の長さによって影響を受ける ( 信号線が長いと抵抗が増大し、
電圧が低下する )。これに対し LVDS では、データストレージは実際の電圧レベルで
なく正と負の電圧値によってのみ区別する。従って、長い信号線でもクリアで安定
したデータストリームを維持した伝送が可能。

出典 : http://www.webopedia.com/TERM/L/LVDS.html

Makefile

プロジェクトの Make に関する指示をファイルにエクスポートしたもの。このファイ
ルは、MPLAB IDE 以外の環境で makeコマンドを実行してプロジェクトをビルドす
る際に使用する。

Makefile をエクスポートするには、[Project]>[Build Options]>[Project] の順にクリック
して、[Directories] タブの [Build Directory Policy] で [Assemble/Compile/Link in the 
project directory] を選択しておく必要がある。
 2012 Microchip Technology Inc. DS51795B_JP - p.79

http://www.webopedia.com/TERM/L/LVDS.html


PICkit™ 3 ユーザガイド
Make Project

アプリケーションを再ビルドするコマンド。前回の完全なコンパイル後に変更された
ソースファイルのみを再コンパイルする。

MCU

Microcontroller Unit の略。マイクロコントローラの事。「μC」と表記する事もある。

MPASM™ アセンブラ (MPASM Assembler)

PIC マイクロコントローラ、KEELOQ® デバイス、マイクロチップ社のメモリデバイス
に対応したマイクロチップ社の再配置可能なマクロアセンブラ。

MPLAB ( 言語ツール名 ) for ( デバイス名 ) (MPLAB Language Tool for Device)

特定のデバイスに対応したマイクロチップ社の C コンパイラ、アセンブラ、リンカ。
言語ツールは、アプリケーションで使用するデバイスに対応したものを選択する必
要がある。例えば PIC18 MCU 用の C コードを作成する場合は「MPLAB C Compiler 
for PIC18 MCU」を使用する。

MPLAB ICD

MPLAB IDE と組み合わせて使用するマイクロチップ社のインサーキット デバッガ。
ICD では、デバッグ回路を内蔵したフラッシュ デバイスがサポートされる。ICE の
中心的なコンポーネントはポッドと呼ばれる。ポッド、ヘッダボード (「デバイス名
-ICD」を搭載 )、ターゲットボード、ケーブル、MPLAB IDE ソフトウェアを組み合
わせて完全なシステムが構成される。

MPLAB ICE 2000/4000

新規デザインには推奨しません。「MPLAB REAL ICE インサーキット エミュレータ」
を参照。

MPLAB IDE と組み合わせて使用するマイクロチップ社の従来型インサーキット エミュ
レータ。MPLAB ICE 2000 では 8 ビット PIC MCU がサポートされる。MPLAB ICE 4000
では PIC18F、PIC24 MCU、dsPIC DSC がサポートされる。ICE の中心的なコンポーネ
ントはポッドと呼ばれる。ポッド、プロセッサ モジュール、ケーブル、MPLAB IDEソフ
トウェアを組み合わせて完全なシステムが構成される。

MPLAB IDE

マイクロチップ社の統合開発環境。エディタ、プロジェクト マネージャ、シミュレータ
が付属する。

MPLAB PM3

マイクロチップ社提供のデバイス プログラマ。PIC18 マイクロコントローラと
dsPIC デジタル シグナル コントローラの書き込みに対応。MPLAB IDE との併用も、
単体での使用も可能。PRO MATE II の後継製品。

MPLAB REAL ICE™ インサーキット エミュレータ (MPLAB REAL ICE™ In-Circuit 
Emulator)

MPLAB IDEと組み合わせて使用するマイクロチップ社の次世代インサーキット エミュ
レータ。PIC MCUと dsPIC DSCをサポートする。ICEの中心的なコンポーネントはポッ
ドと呼ばれる。ポッド、ドライバ (および場合によってはレシーバ ) カード、ケーブル、
MPLAB IDEソフトウェアを組み合わせて完全なシステムが構成される。

MPLAB SIM

MPLAB IDE と組み合わせて使用するマイクロチップ社のシミュレータで、PIC MCU
と dsPIC DSC に対応する。

MPLAB Starter Kit for ( デバイス名 ) (MPLAB Starter Kit for Device)

特定のデバイスでの作業を開始する上で必要となるものを全てセットにしたマイクロ
チップ社のスタータキット。既製のアプリケーションの動作を確認した後で、一部を
変更してカスタム アプリケーションとしてデバッグとプログラムを行う。
DS51795B_JP - p.80  2012 Microchip Technology Inc.



用語集
MPLIB™ オブジェクト ライブラリアン (MPLIB™ Object Librarian)

MPLAB IDE と組み合わせて使用するマイクロチップ社のライブラリアン。MPLIB ラ
イブラリアンは、MPASM アセンブラ (mpasm または mpasmwin v2.0) または MPLAB 
C18 C コンパイラで作成した COFF オブジェクト モジュールに使用するオブジェクト 
ライブラリアン。

MPLINK™ オブジェクト リンカ (MPLINK™ Object Linker)

マイクロチップ社の MPASM アセンブラと C18 C コンパイラに対応したオブジェクト 
リンカ。マイクロチップ社の MPLIB ライブラリアンとの併用も可能。MPLAB IDE に統
合して使用できるように設計されているが、MPLAB IDE 以外の環境でも使用できる。

MRU

Most Recently Used の略。最近使用したファイルおよびウィンドウのこと。MPLAB 
IDE のメインメニューで選択できる。

NOP

No Operation の略。実行してもプログラム カウンタが進むだけで何も動作を行わない
命令。

OTP

One Time Programmable の略。パッケージに窓のない EPROM デバイス。EPROM
を消去するには紫外線照射が必要なため、パッケージに窓のあるデバイスしか消去
できない。

PC

パーソナル コンピュータまたはプログラム カウンタの略。

PICkit 1/2/3 (PICkit 1, 2, and 3)

マイクロチップ社の開発用デバイス プログラマで、Debug Express によるデバッグ
機能を備える。サポートしているデバイスの種類は、各ツールの Readme ファイル
を参照。

PIC MCU (PIC MCUs)

マイクロチップ社の全てのマイクロコントローラ ファミリの総称。

PICSTART Plus

マイクロチップ社提供の開発用デバイス プログラマ。8/14/28/40 ピンの PIC マイクロ
コントローラのプログラミングに対応。書き込みには必ず MPLAB IDE ソフトウェア
を使用する。

PRO MATE II

生産終了品です。「MPLAB PM3」を参照してください。

マイクロチップ社提供のデバイス プログラマ。ほとんどの PIC マイクロコントロー
ラ、メモリ、KEELOQ デバイスへの書き込みに対応。MPLAB IDE との併用も、単体
での使用も可能。

PWM 信号 (PWM Signals)

パルス幅変調 (Pulse Width Modulation) 信号。一部の PIC MCU には周辺モジュール
として PWM が内蔵されている。

RAM

Random Access Memory の略。データメモリ。任意の順にメモリ内の情報にアクセ
スできる。

ROM

Read Only Memory の略。プログラムメモリ。メモリの内容を変更できない。
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Run

エミュレータを Halt から解放するコマンド。エミュレータはアプリケーション コード
を実行し、I/O に対してリアルタイムに変更、応答を行う。

SFR

「特殊機能レジスタ」を参照。

Single Step

コードを 1 命令ずつ実行するコマンド。1 命令を実行するたびに、MPLAB IDE のレジ
スタ ウィンドウ、ウォッチ変数、ステータス ディスプレイの表示が更新されるため、
命令実行を解析してデバッグできる。C コンパイラのソースコードもシングルステップ
実行できるが、その場合は 1 命令ずつ実行されるのではなく、高級言語の C で記述さ
れたコードの 1 行から生成される全てのアセンブリレベル命令がシングルステップで
実行される。

Serialized Quick Turn Programming

デバイス プログラマでマイクロコントローラをプログラムする際に、各デバイスに
異なるシリアル番号を書き込めるようにする機能。エントリコード、パスワード、
ID 番号等を書き込む目的で使用する。

SQTP

「Serialized Quick Turn Programming」を参照。

Step Into

Single Step と同じコマンド。Step Over とは異なり、Step Into では CALL命令に
よって呼び出されるサブルーチンもステップ実行される。

Step Out

現在ステップ実行中のサブルーチンから抜け出すためのコマンド。このコマンドを実
行すると、サブルーチンの残りのコードが全て実行され、サブルーチンのリターンア
ドレスで実行が停止する。

Step Over

Step Over を実行すると、サブルーチン内はステップ実行せずにデバッグできる。
Step Over では、CALL命令があると CALLの次の命令にブレークポイントが設定さ
れる。何らかの理由により、サブルーチンが無限ループになる等、正しくリターン
しない場合、次のブレークポイントには到達しない。CALL命令の処理以外は、Step 
Over コマンドと Single Step コマンドは同じ。

USB

Universal Serial Bus の略。2 本のシリアル伝送線で PC と外部周辺機器の通信を行
う外部周辺インターフェイス規格。USB 1.0/1.1 でサポートされるデータ転送レート
は 12 Mbps。USB 2.0 (Hi-Speed USB) は最大 480 Mbps のデータレートをサポート
している。

WDT

「ウォッチドッグ タイマ」を参照。

アーカイバ (Archiver)

ライブラリを作成、操作するためのツール。

アーカイブ (Archive)

再配置可能なオブジェクト モジュールを集めたもの。複数のソースファイルをオブ
ジェクト ファイルにアセンブルした後、アーカイバを使ってこれらオブジェクト 
ファイルを 1 つのライブラリ ファイルにまとめると生成される。ライブラリをオブ
ジェクト モジュールや他のライブラリとリンクすると、実行コードが生成される。
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アクセス エントリ ポイント (Access Entry Points)

リンク時に定義されていない可能性のある関数に、セグメントの境界を越えて制御
を渡すための手段。ブートセグメントとセキュア アプリケーション セグメントを
別々にリンクする方法も提供する。

アクセスメモリ (Access Memory)

PIC18 のみ – PIC18 でバンク セレクト レジスタ (BSR) の設定にかかわらずアクセス
できる特殊なレジスタ。

アセンブラ (Assembler)

アセンブリ言語のソースコードをマシンコードに変換する言語ツール。

アセンブリ言語 (Assembly Language)

2 進数のマシンコードをシンボル表現で記述したプログラミング言語。

アップロード (Upload)

エミュレータやプログラマ等のツールからホスト PC へ、またはターゲットボード
からエミュレータへデータを転送する事。

アドレス (Address)

メモリ内の位置を一意に特定する値。

アプリケーション (Application)

PIC® マイクロコントローラで制御されるソフトウェアとハードウェアを組み合わせ
たもの。

アルファベット文字 (Alphabetic Character)

アルファベットの小文字と大文字の総称 (a, b, …, z, A, B, …, Z)。

イベント (Event)

アドレス、データ、パスカウント、外部入力、サイクルタイプ ( フェッチ、R/W)、
タイムスタンプ等、バスサイクルを記述したもの。トリガ、ブレークポイント、割
り込みを記述するために使用する。

入れ子の深さ (Nesting Depth)

マクロに他のマクロを含める事のできる階層の数。

インポート (Import)

Hex ファイル等の外部ソースから MPLAB IDE にデータを取り込む事。

ウォッチドッグ タイマ (Watchdog Timer)

PIC マイクロコントローラに内蔵されたタイマの 1 つで、ユーザが設定した期間が
経過するとプロセッサをリセットする。WDT の有効化 / 無効化、設定はコンフィグ
レーション ビットで行う。

ウォッチ変数 (Watch Variable)

デバッグ セッション中に [Watch] ウィンドウで観察できる変数。

英数字 (Alphanumeric)

アルファベット文字と 0 ～ 9 の 10 進数の数字の総称。

永続データ (Persistent Data)

クリアも初期化も行えないデータ。デバイスをリセットしてもアプリケーションが
データを保持できるようにするために使用する。

エクスポート (Export)

MPLAB IDE のデータを標準フォーマットで外部に出力する事。
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エピローグ (Epilogue)

コンパイラで生成したコードのうち、スタック領域の割り当て解除、レジスタの復
帰、ランタイムモデルで指定したその他のマシン固有の要件を実行するコード部分。
エピローグは関数のユーザコードの後、関数リターンの直前に実行される。

エミュレーション (Emulation)

エミュレーション メモリに読み込んだソフトウェアを、あたかもマイクロコント
ローラに読み込んだファームウェアのように実行する事。

エミュレーション メモリ (Emulation Memory)

エミュレータに内蔵されたプログラムメモリ。

エミュレータ (Emulator)

エミュレーションを実行するハードウェア。

エミュレータ システム (Emulator System)

MPLAB ICE 2000 および MPLAB ICE 4000 の場合、エミュレータ システムはポッド、
プロセッサ モジュール、デバイスアダプタ、ターゲットボード、ケーブル、MPLAB 
IDE ソフトウェアで構成される。MPLAB REAL ICE の場合、ポッド、ドライバ ( およ
び場合によってはレシーバ ) カード、ターゲットボード、ケーブル、MPLAB IDE ソフ
トウェアで構成される。

エラー (Errors)

プログラムの処理を継続できない問題が発生するとエラーとして報告される。可能な
場合、エラーは問題が発生したソースファイル名と行番号を特定する。

エラーファイル (Error File)

言語ツールから出力されたエラーメッセージと診断結果を記録したファイル。

演算子 (Operators)

定義可能な式を構成する際に使用される「+」や「-」等の記号。各演算子に割り当て
られた優先順位に基づいて式が評価される。

エンディアン (Endianness)

マルチバイト オブジェクトにおけるバイトの並び順。

オフチップメモリ (Off-Chip Memory)

PIC18 で選択できるメモリオプション。ターゲットボード上のメモリを使用するか、
または全てのプログラムメモリをエミュレータから供給する。
[Options]>[Development Mode] の順にクリックして [Memory] タブでオフチップメモ
リの選択を行う。

オブジェクト コード (Object Code)

アセンブラまたはコンパイラによって生成されるマシンコード。

オブジェクト ファイル (Object File)

マシンコードを含むファイル。デバッグ情報を含む事もある。そのまま実行できる
ものと、他のオブジェクト ファイル ( ライブラリ等 ) とリンクしてから完全な実行
プログラムを生成する再配置可能形式のものがある。

オブジェクト ファイル ディレクティブ (Object File Directives)

オブジェクト ファイル作成時にのみ使用するディレクティブ。

オペコード (Opcodes)

Operational Code の略。「ニーモニック」を参照。

拡張マイクロコントローラ モード (Extended Microcontroller Mode)

拡張マイクロコントローラ モードでは、内蔵プログラムメモリと外部メモリの両方
が利用できる。プログラムメモリのアドレスが PIC18 の内部メモリ空間より大きい
場合、自動的に外部メモリの実行に切り換わる。
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拡張モード (Extended Mode)

コンパイラの動作モードの 1 つ。拡張命令 (ADDFSR、ADDULNK、CALLW、MOVSF、
MOVSS、PUSHL、SUBFSR、SUBULNK) とリテラル オフセットによるインデックス アド
レス指定を利用できる。

環境 (Environment)

IDE – アプリケーション開発に特化したデスクトップ環境。

MPLAB PM3 – デバイスのプログラミングに関する設定ファイルを保存したフォルダ。
このフォルダを SD/MMC カードに転送できる。

緩和 (Relaxation)

ある命令を、機能が同じでよりサイズの小さい命令に変換する事。コードサイズを
抑えるために便利である。最新の MPLAB ASM30 には、CALL命令を RCALL命令
に緩和する機能がある。この変換は、現在の命令から +/- 32k 命令ワード以内にあ
るシンボルを呼び出す場合に行われる。

外部 RAM (External RAM)

オフチップの読み書き可能なメモリ。

外部シンボル (External Symbol)

外部リンケージを持つ識別子のシンボル。参照の場合と定義の場合がある。

外部シンボル解決 (External Symbol Resolution)

リンカが全ての入力モジュールの外部シンボル定義を 1 つにまとめ、全ての外部シ
ンボル参照を解決しようとするプロセス。外部シンボル参照に対応する定義が存在
しない場合、リンカエラーとなる。

外部入力ライン (External Input Line)

外部信号に基づいてイベントを設定するための外部入力信号ロジック プローブ ライン
(TRIGIN)。

外部ラベル (External Label)

外部リンケージを持つラベル。

外部リンケージ (External Linkage)

関数や変数が、それ自身が定義されたモジュールの外部から参照できる場合、外部
リンケージを持つという。

記憶域クラス (Storage Class)

指定されたオブジェクトを格納する記憶場所の持続期間を決定する。

記憶域修飾子 (Storage Qualifier)

宣言されるオブジェクトの特別な属性を示す (const等 )。

基数 (Radix)

アドレスを指定する際の記数法 (16 進法、10 進法 ) の底。

警告 (Warning)

IDE – デバイス、ソフトウェア ファイル、装置に物理的な損傷を与える可能性のあ
る状況で、ユーザに注意を促すために表示されるメッセージ。

ALU30、C30 – 問題となる可能性のある状態を警告として報告するが、処理は停止
されない。MPLAB C30 の警告メッセージではソースファイル名と行番号が報告され
るが、エラーメッセージと区別するために「warning:」の文字列も付加される。

高級言語 (High Level Language)

プログラムを記述するための言語で、プロセッサから見てアセンブリよりも遠い位
置関係にあるもの。
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校正メモリ (Calibration Memory)

PIC マイクロコントローラの内蔵 RC オシレータやその他の周辺モジュールの校正
値を格納するための特殊機能レジスタ。

国際標準化機構 (International Organization for Standardization)

コンピューティングや通信をはじめ、多くのテクノロジとビジネス関連の標準規格
の策定を行っている団体。

コマンドライン インターフェイス (Command Line Interface)

プログラムとユーザのやり取りをテキストの入出力だけで行う方法。

コンパイラ (Compiler)

高級言語で記述されたソースファイルをマシンコードに変換するプログラム。

コンフィグレーション ビット (Configuration Bits)

PIC マイクロコントローラの動作モードを設定するために書き込む専用ビット。コン
フィグレーション ビットは事前プログラミングされている場合とされていない場合
がある。

再入可能 (Reentrant)

1 つの関数を複数呼び出して同時に実行できる事。直接または間接再帰、あるいは
割り込み処理中の実行によって起こる事がある。

再帰 (Recursion)

定義した関数やマクロがそれ自身を呼び出す事。再帰マクロを作成する際は、再帰
から抜けずに無限ループとなりやすいため注意が必要。

再帰呼び出し (Recursive Calls)

直接または間接的に自分自身を呼び出す関数。

再配置 (Relocation)

リンカが絶対アドレスを再配置可能セクションに割り当てる事。再配置可能セクション
内のシンボルは全て新しいアドレスに更新される。

再配置可能 (Relocatable)

アドレスが固定されたメモリ番地に割り当てられていないオブジェクト。

再配置可能セクション (Relocatable Section)

ALU30 – アドレスが固定されていない ( 絶対アドレスでない ) セクション。再配置可
能セクションには、再配置と呼ばれるプロセスによって、リンカがアドレスを割り当
てる。

左辺値 (L-value)

検査または変更が可能なオブジェクトを指し示す式。左辺値は代入演算子の左側で
使用する。

シーケンス ブレークポイント (Sequenced Breakpoints)

シーケンスで発生するブレークポイント。ブレークポイントのシーケンス実行はボ
トムアップ方式で行われる。つまり、シーケンスの最後のブレークポイントが最初
に発生する。

シェル (Shell)

MPASM アセンブラにおいて、マクロアセンブラへの入力を行うためのプロンプト 
インターフェイス。MPASM アセンブラには DOS 用シェルと Windows 用シェルの
2 種類がある。

式 (Expressions)

算術演算子または論理演算子で区切った定数または記号の組み合わせ。
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識別子 (Identifier)

関数または変数の名前。

システム ウィンドウ コントロール (System Window Control)

ウィンドウや一部のダイアログの左上隅にあるコントロール。通常、このコントロール
をクリックすると、[ 最小化 ]、[ 最大化 ]、[ 閉じる ] 等のメニュー項目がポップアップ表
示される。

シナリオ (Scenario)

MPLAB SIM シミュレータにおいて、スティミュラス制御を具体的に設定したもの。

シミュレータ (Simulator)

デバイスの動作をモデリングするソフトウェア プログラム。

修飾子 (Qualifier)

パスカウンタで使用する、または複合トリガにおける次の動作前のイベントとして
使用するアドレスまたはアドレス範囲。

初期化済みデータ (Initialized Data)

初期値を指定して定義されたデータ。C では、

int myVar=5;

として定義した変数は初期化済みデータセクションに格納される。

シンボル (Symbol)

プログラムを構成する各種の要素を記述する汎用のメカニズム。関数名、変数名、
セクション名、ファイル名、struct/enum/union タグ名等がある。MPLAB IDE では、
主に変数名、関数名、アセンブリラベルをシンボルと呼ぶ。リンク実行後は、シン
ボルの値はメモリ内の値となる。

シンボル ( 絶対シンボル ) (Symbol, Absolute)

アセンブリの .equディレクティブによる定義等、即値を表す。

実行可能コード (Executable Code)

読み込んで実行できる形式のソフトウェア。

条件付きアセンブリ (Conditional Assembly)

アセンブリ言語で、ある特定の式のアセンブル時の値に基づいて含まれたり除外さ
れたりするコード。

条件付きコンパイル (Conditional Compilation)

プログラムの一部を、プリプロセッサ ディレクティブで指定した特定の定数式が真
の場合のみコンパイルする事。

推奨しない機能 (Deprecated Features)

後方互換性のためにサポートされているだけで現在は使用されておらず、いずれ廃止
される事が決まっている機能。

スキッド (Skid)

ハードウェア ブレークポイントを使ってプロセッサを停止する場合、ブレークポイント
からさらに 1 つ以上の命令を実行してプロセッサが停止する事がある。ブレークポイン
トの後に実行される命令の数をスキッドと呼ぶ。

スキュー (Skew)

命令実行に関する情報は、異なる複数のタイミングでプロセッサバスに現れる。
例えば、実行されるオペコードは直前の命令の実行時にフェッチとしてバスに現れ
る。ソースデータのアドレスと値、およびデスティネーション データのアドレスは、
オペコードが実際に実行される時にバスに現れる。デスティネーション データの値
は次の命令の実行時にバスに現れる。トレースバッファには、1 インスタンスでバス
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上に存在する情報がキャプチャされる。従って、トレースバッファの 1 エントリには
3 つの命令の実行情報が含まれる。1 つの命令実行で、ある情報から次の情報までに
キャプチャされるサイクル数をスキューと呼ぶ。

スタック ( ソフトウェア スタック ) (Stack, Software)

アプリケーションがリターンアドレス、関数パラメータ、ローカル変数を保存する
のに使用するメモリ。高級言語でコードを開発する場合、このメモリは通常コンパ
イラによって管理される。

スタック ( ハードウェア スタック ) (Stack, Hardware)

PIC マイクロコントローラで関数呼び出しを行う時にリターンアドレスを格納する
場所。

スタティック RAM (SRAM) (Static RAM or SRAM)

Static Random Access Memory の略。ターゲットボード上の読み書き可能なプログ
ラムメモリ。頻繁に書き換える必要のないプログラムを書き込む。

ステータスバー (Status Bar)

MPLAB IDE ウィンドウの一番下にあるバーで、カーソル位置、開発モードとデバイス、
アクティブなツールバー等に関する情報が表示される。

スティミュラス (Stimulus)

シミュレータへの入力。すなわち、外部信号に対する応答をシミュレートするために
生成されるデータ。通常、このデータはテキストファイルにアクションのリストとし
て記述される。スティミュラスの種類には、非同期、同期 ( ピン )、クロック動作、
レジスタがある。

ストップウォッチ (Stopwatch)

実行サイクルを測定するためのカウンタ。

制御ディレクティブ (Control Directives)

アセンブリ言語コード内で使用するディレクティブで、指定した式のアセンブル時の
値に基づいてコードを含めるか除外するかを決定する。

セクション (Section)

特定のメモリ番地にあるアプリケーションの一部。

セクション属性 (Section Attribute)

セクションの特徴を表す情報 (accessセクション等 )。

絶対セクション (Absolute Section)

リンカによって変更されない固定 ( 絶対 ) アドレスを持つセクション。

ソースコード (Source Code)

プログラマ ( 人間 ) が記述したコンピュータ プログラム。プログラミング言語で記
述されたソースコードは、マシンコードに変換して実行するか、またはインタプリ
タによって実行される。

ソースファイル (Source File)

ソースコードを記述した ASCII テキストファイル。

相互参照ファイル (Cross Reference File)

シンボルテーブルとそのシンボルを参照するファイルリストを参照するファイル。
シンボルが定義されている場合、リストの最初のファイルがシンボル定義の位置と
なる。残りのファイルにはシンボルへの参照が含まれる。

属性 (Attribute)

C プログラムの変数または関数の特徴を表す情報で、マシン固有の特性を記述する
目的で使用する。
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属性 ( セクション属性 ) (Attribute, Section)

「executable」、「readonly」、「data」等、セクションの特徴を表す情報。アセンブラ
の .sectionディレクティブでフラグとして指定できる。

ターゲット (Target)

ユーザ ハードウェアの事。

ターゲット アプリケーション (Target Application)

ターゲットボードに読み込んだソフトウェア。

ターゲット プロセッサ (Target Processor)

ターゲット アプリケーション ボードで使用されているマイクロコントローラ デバイス。

ターゲットボード (Target Board)

ターゲット アプリケーションを構成する回路とプログラマブルなデバイス。

ダウンロード (Download)

ホストから別のデバイス ( エミュレータ、プログラマ、ターゲットボード等 ) にデータ
を送信する事。

致命的エラー (Fatal Error)

コンパイルがただちに停止するようなエラー。メッセージも出力されない。

中央演算処理装置 (Central Processing Unit)

デバイス内で、実行する正しい命令をフェッチし、デコードして実行する装置。必要
に応じて、算術論理演算装置 (ALU) と組み合わせて命令実行を完了する。プログラム
メモリのアドレスバス、データメモリのアドレスバス、スタックへのアクセスを制御
する。

ツールバー (Tool Bar)

MPLAB IDE の機能を実行するためのボタン ( アイコン ) を縦または横に並べたもの。

テンプレート (Template)

後でファイルに挿入するために作成するテキスト行。MPLAB エディタでは、テンプ
レートはテンプレート ファイルに保存される。

データ ディレクティブ (Data Directives)

アセンブラによって行われるプログラムメモリまたはデータメモリの割り当てを制
御するディレクティブ。データ項目をシンボル ( 意味のある名前 ) を使って参照する
手段としても使われる。

データメモリ (Data Memory)

マイクロチップ社の MCU と DSC では、データ メモリ (RAM) は汎用レジスタ (GPR)
と特殊機能レジスタ (SFR) で構成される。EEPROM データ メモリを内蔵したデバイ
スもある。

ディレクティブ (Directives)

言語ツールの動作を制御するためにソースコードに記述するステートメント。

デジタル シグナル コントローラ (Digital Signal Controller)

デジタル信号処理機能を搭載したマイクロコントローラ。マイクロチップ社の
dsPIC DSC デバイス等。

デジタル シグナル プロセッサ (Digital Signal Processor)

デジタル信号処理用に設計されたマイクロプロセッサ。

デジタル信号処理 (Digital Signal Processing)

デジタル信号をコンピュータで処理する事。通常は、アナログ信号 ( 音声または画像 )
をデジタル形式に変換 ( サンプリング ) して処理する事をいう。
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デバイス プログラマ (Device Programmer)

マイクロコントローラ等、電気的に書き込み可能な半導体デバイスにプログラミング
を行うためのツール。

デバッガ (Debugger)

デバッグを実行するハードウェア。

デバッガシステム (Debugger System)

デバッガ本体、プロセッサ モジュール、デバイスアダプタ、ターゲットボード、
ケーブル、MPLAB IDE ソフトウェアで構成されるシステム。

デバッグ情報 (Debugging Information)

コンパイラとアセンブラでこのオプションを選択すると、アプリケーション コード
のデバッグに使える各種レベルの情報が出力される。デバッグ オプションの選択の
詳細はコンパイラまたはアセンブラのマニュアルを参照。

特殊機能レジスタ (Special Function Registers)

I/O プロセッサ機能、I/O ステータス、タイマ等の各種モードや周辺モジュールを制
御するレジスタ専用に使用するデータメモリ (RAM) 領域。

匿名構造体 (Anonymous Structure)

C30 – 名前のない構造体。

C18 – C 共用体のメンバーで、名前のない構造体。匿名構造体のメンバーは、その構
造体を包含している共用体のメンバーと同じようにアクセスできる。例えば以下の
サンプルコードでは、hiと loは共用体 casterに含まれる匿名構造体のメンバー
である。

union castaway
 int intval;
 struct {
  char lo; //accessible as caster.lo
  char hi; //accessible as caster.hi
 };
} caster;

トライグラフ (Trigraphs)

「??」で始まる 3 文字のシーケンス。ISO C で定義されており、1 つの文字に置換さ
れる。

トリガ出力 (Trigger Output)

任意のアドレスまたはアドレス範囲で生成でき、トレースおよびブレークポイント
設定から独立したエミュレータ出力信号の事。トリガ出力ポイントはいくつでも設
定できる。

トレース (Trace)

プログラム実行のログを記録するエミュレータまたはシミュレータの機能。エミュ
レータはプログラム実行のログをトレースバッファに記録し、これを MPLAB IDE の
トレース ウィンドウにアップロードする。

トレースマクロ (Trace Macro)

エミュレータ データからのトレース情報を提供するマクロ。これはソフトウェア 
トレースのため、トレースを利用するには、マクロをコードに追加し、コードを再
コンパイルまたは再アセンブルし、ターゲット デバイスにこのコードをプログラム
する必要がある。

トレースメモリ (Trace Memory)

エミュレータに内蔵されたトレース用のメモリ。トレースバッファとも呼ばれる。
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内部リンケージ (Internal Linkage)

関数や変数が、それ自身が定義されたモジュールの外部からアクセスできない場合、
内部リンケージを持つという。

ニーモニック (Mnemonics)

マシンコードと 1 対 1 で対応したテキスト命令。オペコードとも呼ばれる。

ネイティブ データサイズ (Native Data Size)

ネイティブ トレースの場合、[Watch] ウィンドウで使用する変数のサイズは選択した
デバイスのデータメモリと同じサイズ (PIC18 の場合は同じバイトサイズ、16 ビット
デバイスの場合は同じワードサイズ ) である必要がある。

ノード (Node)

MPLAB IDE のプロジェクトを構成するコンポーネント。

パスカウンタ (Pass Counter)

イベント ( 特定のアドレスの命令を実行する等 ) が発生するたびに値をデクリメント
するカウンタ。パスカウンタの値がゼロになると、イベントの条件が満たされる。
パスカウンタはブレークロジック、トレースロジック、複合トリガダイアログの任
意のシーケンシャル イベントに割り当てられる。

パワーオン リセット エミュレーション (Power-on-Reset Emulation)

データ RAM 領域にランダムな値を書き込んで、初回電源投入時の RAM の非初期化
値をシミュレートするソフトウェア ランダム化処理。

ヒープ (Heap)

動的メモリ割り当てに使われるメモリ領域。メモリブロックの割り当てと解放は実
行時に任意の順序で行われる。

非拡張モード (Non-Extended Mode)

コンパイラの動作モードの 1 つ。拡張命令またはリテラル オフセットによるイン
デックス アドレス指定を利用しない。

非初期化データ (Uninitialized Data)

初期値なしで定義されたデータ。C では、

int myVar; 

として定義した変数は非初期化データ セクションに格納される。

非同期 (Asynchronously)

複数のイベントが同時には発生しない事。一般に、プロセッサ実行中の任意の時点
で発生する割り込みに言及する際に使う。

非同期スティミュラス (Asynchronous Stimulus) 

シミュレータ デバイスへの外部入力をシミュレートするために生成されるデータ。

非リアルタイム (Non Real Time)

ブレークポイントで停止中、またはシングルステップ実行中のプロセッサ、あるい
はシミュレータ モードで動作中の MPLAB IDE を指す。

ビルド (Build)

全てのソースファイルをコンパイルおよびリンクしてアプリケーションを作成する
事。

ファイル レジスタ (File Registers)

汎用レジスタ (GPR) と特殊機能レジスタ (SFR) で構成される内蔵のデータメモリ。

ファントムバイト (Phantom Byte)

dsPIC アーキテクチャで、24 ビット命令ワードを 32 ビット命令ワードと見なして
扱う場合に使用する未実装バイト。dsPIC の hex ファイルに見られる。
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フィルタ (Filter)

トレース ディスプレイまたはデータファイルにどのデータを含めるか / 除外するか
を選択するもの。

不揮発性ストレージ (Non-Volatile Storage)

電源を OFF にしても内容が失われないストレージ デバイス。

フラッシュ (Flash)

データの書き込みと消去をバイト単位ではなくブロック単位で行えるタイプの
EEPROM。

フリースタンディング (Free-Standing)

複素数型を使っておらず、ライブラリ (ANSI C89 規格第 7 節 ) で規定する機能の使
用が標準ヘッダ (<float.h>、<iso646.h>、<limits.h>、<stdarg.h>、
<stdbool.h>、<stddef.h>、<stdint.h>) の内容のみに限定されている厳密な
規格合致プログラムを受理する処理系。

フレームポインタ (Frame Pointer)

スタックベースの引数とスタックベースのローカル変数の境界となるスタック番地
を指し示すポインタ。ここを基準にすると、現在の関数のローカル変数やその他の
値に容易にアクセスできる。

ブックマーク (Bookmarks)

ファイル内の特定の行に簡単な操作でアクセスできるようにする機能。

ブックマークの有効 / 無効の切り替え、前後のブックマークへの移動、すべてのブック
マークのクリア等、ブックマークの管理は [Edit] メニューで [Bookmarks] をクリックし
て行う。

ブレークポイント (Breakpoint)

ハードウェア ブレークポイント : 実行するとファームウェアの実行が停止するイベント。

ソフトウェア ブレークポイント : ファームウェアの実行が停止するアドレス。通常、
特別な Break 命令によって実行が停止される。

プラグイン (Plug-ins)

MPLAB IDE では、標準コンポーネントにプラグイン モジュールを追加する事によって、
各種ソフトウェア / ハードウェア ツールに対応する。一部のプラグイン ツールは、
[Tools] メニューから利用できる。

プラグマ (Pragma)

特定のコンパイラにとって意味を持つディレクティブ。一般に、実装で定義した情報
をコンパイラに伝達するために使われる。MPLAB C30 は属性を利用してこの情報を
伝達する。

プログラム カウンタ (Program Counter)

現在実行中の命令のアドレスを格納した場所。

プログラム カウンタ ユニット (Program Counter Unit)

ALU30 – プログラムメモリのレイアウトを概念的に表現したもの。プログラム カウン
タは 1 命令ワードで 2 つインクリメントする。実行可能セクションでは、2 プログラ
ム カウンタ ユニットは 3 バイトに相当する。読み出し専用セクションでは、2 プログ
ラム カウンタ ユニットは 2 バイトに相当する。

プログラムメモリ (Program Memory)

IDE – デバイス内で命令が保存されるメモリ領域。また、エミュレータまたはシミュ
レータにダウンロードしたターゲット アプリケーションのファームウェアを格納す
るメモリ領域もプログラムメモリと呼ばれる。

ALU30/C30 – デバイス内で命令が保存されるメモリ領域。
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プロジェクト (Project)

アプリケーションのビルドに必要なファイル ( ソースコードやリンカ スクリプト 
ファイル等 ) 一式と、各種ビルドツールやビルドオプションとの関連付けをまとめ
たもの。

プロトタイプ システム (Prototype System)

ユーザのターゲット アプリケーションまたはターゲットボードの事。

プロファイル (Profile)

MPLAB SIM シミュレータにおいて、実行したスティミュラスをレジスタ別に一覧表
示したもの。

プロローグ (Prologue)

コンパイラで生成したコードのうち、スタック領域の割り当て、レジスタの退避、
ランタイムモデルで指定したその他のマシン固有の要件を実行するコード部分。
プロローグは、関数のユーザコードの前に実行される。

ベクタ (Vector)

リセットまたは割り込みが発生した時にアプリケーションのジャンプ先となるメモリ
番地。

ホスト PC (PC Host)

サポートされた Windows オペレーティング システムが動作する PC。

ポッド (Pod)

MPLAB REAL ICE システムの場合 : ヘッダボードまたはターゲットボードに装着され
た ICE デバイス用のエミュレーション制御回路を内蔵。ICE デバイスとは、ICE 回路
を内蔵した標準デバイス、または標準デバイスの特別な ICE バージョン ( デバイス名
-ICE) を指す。

MPLAB ICD の場合 : ヘッダボードまたはターゲットボードに装着された ICD デバイ
ス用のデバッグ制御回路を内蔵。ICD デバイスとは、ICD 回路を内蔵した標準デバ
イス、または標準デバイスの特別な ICD バージョン ( デバイス名 -ICD) を指す。

MPLAB ICE 2000/4000 の場合 : エミュレーション メモリ、トレースメモリ、イベン
トおよびサイクルタイマ、トレース / ブレークポイント ロジックを含む外付けのエ
ミュレータ本体。

マイクロコントローラ (Microcontroller)

CPU、RAM、プログラムメモリ、I/O ポート、タイマ等、多くの機能が統合された
チップ。

マイクロコントローラ モード (Microcontroller Mode)

PIC18 マイクロコントローラで設定可能なプログラムメモリ構成の 1 つ。マイクロ
コントローラ モードでは、内部実行のみが許可される。つまり、マイクロコント
ローラ モードでは内蔵プログラムメモリしか利用できない。

マイクロプロセッサ モード (Microprocessor Mode)

PIC18 マイクロコントローラで設定可能なプログラムメモリ構成の 1 つ。マイクロ
プロセッサ モードでは、内蔵プログラムメモリは使用されない。プログラムメモリ
全体が外部にマッピングされる。

マクロ (Macro)

マクロ命令。一連の命令シーケンスを短い名前で表現した命令。

マクロ ディレクティブ (Macro Directives)

マクロ定義の中で実行とデータ割り当てを制御するディレクティブ。
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マシンコード (Machine Code)

コンピュータ プログラムをプロセッサが実際に読み出して解釈できる形式で表現し
たもの。2 進数のマシン コードで記述されたプログラムは、マシン命令のシーケンス
( 命令間にデータを挟むこともある ) で構成される。ある特定のプロセッサで使用で
きる全ての命令の集合を「命令セット」という。

マシン語 (Machine Language)

ある CPU が翻訳を必要とせず実行できる命令の集合。

未割り当てセクション (Unassigned Section)

リンカのコマンドファイルで特定のターゲット メモリ ブロックに割り当てられてい
ないセクション。リンカは、未割り当てセクションを割り当てるターゲット メモリ 
ブロックを検出する必要がある。

命令 (Instructions)

CPU に対して特定の演算を実行するように指示するビット列。演算の対象となる
データを含める事もできる。

命令セット (Instruction Set)

特定のプロセッサが理解できるマシン語命令の集合。

メッセージ (Message)

言語ツールの動作に問題が発生したことを知らせる文字列。メッセージが表示され
ても処理は停止しない。

メモリモデル (Memory Model)

C30 – アプリケーションで利用可能なメモリを表現したもの。

C18 – プログラムメモリを指し示すポインタのサイズに関する規定を記述したもの。

優先順位 (Precedence)

式の評価順を定義した規則。

読み出し専用メモリ (Read Only Memory)

恒久的に保存されているデータへの高速アクセスが可能なメモリ ハードウェア。
ただし、データの追加や変更は不可。

ライブラリ (Library)

「アーカイブ」を参照。

ライブラリアン (Librarian)

「アーカイバ」を参照。

ランタイムモデル (Run-time Model)

ターゲット アーキテクチャのリソースの使用を記述したもの。

リアルタイム (Real Time)

インサーキット エミュレータまたはデバッガが Halt 状態から解放されると、プロセッサ
の実行はリアルタイム モードとなり、通常のチップと全く同じ挙動をする。リアルタ
イム モードでは、エミュレータのリアルタイム トレース バッファが有効になり、選択
した全てのサイクルを常時キャプチャする。また、全てのブレーク ロジックが有効に
なる。インサーキット エミュレータまたはデバッガでは、有効なブレークポイントで
停止するか、またはユーザによって実行が停止されるまでプロセッサはリアルタイム
で動作する。

シミュレータでは、ホスト CPU でシミュレート可能な最大速度でマイクロコント
ローラの命令を実行する事をリアルタイムと呼ぶ。
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用語集
リアルタイム ウォッチ (Real-Time Watch)

アプリケーション実行中に [Watch] ウィンドウで変数の値がリアルタイムに変化す
る事。リアルタイム ウォッチの設定方法は、各ツールのマニュアルを参照。リアル
タイム ウォッチをサポートしていないツールもある。

リスティング ディレクティブ (Listing Directives)

アセンブラのリスティング ファイルのフォーマットを制御するディレクティブ。
タイトルや改ページ指示等、リスティング ファイルに関する各種の設定を行う。

リスティング ファイル (Listing File)

ソースファイルにある各 C ソース ステートメント、アセンブリ命令、アセンブラ 
ディレクティブ、マクロに対して生成されたマシン コードを記述した ASCII テキス
トファイル。

リトル エンディアン (Little Endian)

マルチバイト データで最下位バイト (LSB) を最下位アドレスに格納するデータ並び
順方式。

量産プログラマ (Production Programmer)

デバイスのプログラムを高速に行えるようにリソースを強化したプログラマ。各種
電圧レベルでのプログラミングに対応し、プログラミング仕様にも完全に準拠して
いる。量産環境ではアプリケーション回路が組立ラインにとどまる時間をなるべく
短くする必要があるため、デバイスへの書き込み時間が特に重視される。

MPLAB PM3、MPLAB REAL ICE インサーキット エミュレータ、MPLAB ICD 3 等、
マイクロチップ社の量産プログラマはこうした要求の厳しい環境にも耐えられるよ
う特に堅牢な設計が採用されている。

一部のハイエンドツールには、さらに専用のアクセサリが用意されている。例えば
MPLAB REAL ICE には、通信と ICSP ( インサーキット シリアル プログラミング ) の
プロセスをさらに高速化する Performance Pak が提供されている。MPLAB PM3 プロ
グラマには、各種デバイスを直接サポートするための交換可能ソケットモジュールが
提供されている。

リンカ (Linker)

オブジェクト ファイルとライブラリを結合し、モジュール間の参照を解決して実行
可能コードを生成する言語ツール。

リンカ スクリプト ファイル (Linker Script Files)

リンカのコマンド ファイル。リンカのオプションを定義し、ターゲット プラット
フォームで利用可能なメモリを記述する。

ループバック テスト ボード (Loop-Back Test Board)

MPLAB REAL ICE インサーキット エミュレータの動作をテストするために用いる。

レイテンシ (Latency)

イベントが発生してからその応答までの時間の長さ。

ロー (raw) データ (Raw Data)

あるセクションに関連付けられたコードまたはデータを 2 進数で表現したもの。

ローカルラベル (Local Label)

マクロ内で LOCAL ディレクティブで定義されたラベル。ローカルラベルは、マクロ
の同一インスタンス内でのみ有効。すなわち、LOCAL として宣言されたシンボルや
ラベルには、ENDM マクロ以降はアクセスできない。

ロジックプローブ (Logic Probes)

マイクロチップ社製エミュレータには、最大 14 のロジックプローブを接続できるも
のがある。ロジックプローブは、外部トレース入力、トリガ出力信号、+5 V、共通
グランドを提供する。
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ワークスペース (WorkSpace)

MPLAB IDE において、デバイスやデバッグツール / プログラマの選択内容、起動中
のウィンドウとその位置等、IDE の各種設定を保存したもの。

ワークブック (Workbook)

MPLAB SIM シミュレータにおいて、SCL スティミュラスの生成に関する設定を保
存したもの。

割り当てセクション (Assigned Section)

リンカのコマンドファイルで特定のターゲット メモリ ブロックに割り当てられた
セクション。

割り込み (Interrupt)

CPU に対する信号の一種。この信号が発生すると、現在動作中のアプリケーション
の実行を一時停止し、制御を割り込みサービスルーチン (ISR) に渡してイベントを
処理する。ISR の実行が完了すると、通常のアプリケーションの実行が再開される。

割り込みサービスルーチン (Interrupt Service Routine)

ALU30、C18、C30 – 割り込みを処理する関数。

IDE – 割り込みが発生すると実行されるユーザ作成コード。通常、発生した割り込み
の種類によってプログラム メモリ内の異なる位置のコードが実行される。

割り込みハンドラ (Interrupt Handler)

割り込み発生時に専用のコードを実行するルーチン。

割り込みベクタ (Interrupt Vector)

割り込みサービスルーチンまたは割り込みハンドラのアドレス。

割り込み要求 (Interrupt Request)

プロセッサの通常の命令実行を一時的に停止し、割り込みハンドラルーチンの実行
開始を要求するイベント。プロセッサによっては複数の割り込み要求イベントを持
ち、優先度の異なる割り込みを処理できるものもある。
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